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Contacting Telestream
To obtain product information, technical support, or provide comments on this guide, contact us using 
our web site, email, or telephone number as listed below.

Resource Contact Information

Telestream, LLC Web Site: www.telestream.net
Sales and Marketing Email: info@telestream.net
Licensing Email: license@telestream.net
Telestream, LLC
848 Gold Flat Road, Suite 1
Nevada City, CA USA 95959

International Reseller 
Support

See the Telestream web site (www.telestream.net/purchase/locate-
reseller.htm) for your regional authorized Telestream reseller.

Vantage Technical 
Support

Web Site: www.telestream.net/telestream-support/vantage/support.htm
Support Email: support@telestream.net
Licensing Email: license@telestream.net
Enterprise Telephone Support: 
U. S. Toll Free: (877) 257-6245
U. S. from outside U.S.: (530) 470-2036
Europe | Middle East | Africa | Asia | Pacific:
 +49 228 280 9141
Terms and times of support services vary, per the terms of your current 
service contract with Telestream.

Telestream Technical 
Writers

Email: techwriter@telestream.net
Share comments about this or other Telestream documents.

Contacting Nagra
For NexGuard technical support or licensing questions, please contact Nagra via email at 
NexGuardCustomerCare@nagra.com.

https://www.telestream.net/telestream-support/vantage/support.htm
mailto:license@telestream.net
mailto:support@telestream.net
https://www.telestream.net
mailto:info@telestream.net
mailto:license@telestream.net
mailto:techwriter@telestream.net
https://www.telestream.net/purchase/locate-reseller.htm
https://www.telestream.net/purchase/locate-reseller.htm
mailtoNexGuardCustomerCare@nagra.com
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Copyrights and Trademark Notices
Copyright © 2022 Telestream, LLC and its Affiliates. All rights reserved. No part of this publication may 
be reproduced, transmitted, transcribed, altered, or translated into any languages without written 
permission of Telestream, LLC. Information and specifications in this document are subject to change 
without notice and do not represent a commitment on the part of Telestream. Specifications subject to 
change without notice.

Telestream, CaptionMaker, Cerify, DIVA, Episode, Flip4Mac, FlipFactory, Flip Player, GraphicsFactory, 
Kumulate, Lightspeed, MetaFlip, Post Producer, ScreenFlow, Switch, Tempo, TrafficManager, Vantage, 
VOD Producer, and Wirecast are registered trademarks and Aurora, ContentAgent, Cricket, e-
Captioning, Inspector, iQ, iVMS, iVMS ASM, MacCaption, Pipeline, Sentry, Surveyor, Vantage Cloud Port, 
CaptureVU, FlexVU, PRISM, Sentry, Stay Genlock, Aurora, and Vidchecker are trademarks of Telestream, 
LLC and its Affiliates. All other trademarks are the property of their respective owners. 

Adobe. Adobe® HTTP Dynamic Streaming Copyright © 2014 Adobe Systems. All rights reserved.

Apple. QuickTime, MacOS X, and Safari are trademarks of Apple, Inc. Bonjour, the Bonjour logo, and the 
Bonjour symbol are trademarks of Apple, Inc.

Avid. Portions of this product Copyright 2012 Avid Technology, Inc.

CoreOS. Developers of ETCD.

Dolby. Dolby and the double-D symbol are registered trademarks of Dolby Laboratories Licensing 
Corporation.

Fraunhofer IIS and Thomson Multimedia. MPEG Layer-3 audio coding technology licensed from 
Fraunhofer IIS and Thomson Multimedia.

Google. VP6 and VP8 Copyright Google Inc. 2014 All rights reserved.

MainConcept. MainConcept is a registered trademark of MainConcept LLC and MainConcept AG. 
Copyright 2004 MainConcept Multimedia Technologies.

Manzanita. Manzanita is a registered trademark of Manzanita Systems, Inc.

MCW. HEVC Decoding software licensed from MCW.

MediaInfo. Copyright © 2002-2013 MediaArea.net SARL. All rights reserved. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL 
THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Microsoft. Microsoft, Windows NT|2000|XP|XP Professional|Server 2003|Server 2008 |Server 
2012|Server 2016|Server 2019, Windows 7, Windows 8, Windows 10, Media Player, Media Encoder, .Net, 
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Internet Explorer, SQL Server 2005|2008|2012|2016|2019, and Windows Media Technologies are 
trademarks of Microsoft Corporation.

NLOG, MIT, Apache, Google. NLog open source code used in this product under MIT License and 
Apache License is copyright © 2014-2016 by Google, Inc., © 2016 by Stabzs, © 2015 by Hiro, Sjoerd 
Tieleman, © 2016 by Denis Pushkarev, © 2015 by Dash Industry Forum. All rights reserved.

SharpSSH2. SharpSSH2 Copyright (c) 2008, Ryan Faircloth. All rights reserved. Redistribution and use in 
source and binary forms, with or without modification, are permitted provided that the following 
conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer:

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and 
the following disclaimer in the documentation and/or other materials provided with the distribution.

Neither the name of Diversified Sales and Service, Inc. nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL 
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE 
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Swagger. Licensed from SmartBear.

Telerik. RadControls for ASP.NET AJAX copyright Telerik All rights reserved.

VoiceAge. This product is manufactured by Telestream under license from VoiceAge Corporation.

x264 LLC. The product is manufactured by Telestream under license from x264 LLC.

Xceed. The Software is Copyright ©1994-2012 Xceed Software Inc., all rights reserved.

ZLIB. Copyright (C) 1995-2013 Jean-loup Gailly and Mark Adler.

 

Other brands, product names, and company names are trademarks of their respective holders, and are 
used for identification purpose only.
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MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT COMPLIES WITH THE 
MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR PACKAGED MEDIA IS EXPRESSLY 
PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE PATENTS IN THE MPEG-2 PATENT PORTFOLIO, 
WHICH LICENSE IS AVAILABLE FROM MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 
80237 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING VIDEO IN COMPLIANCE 
WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/OR (ii) DECODING MPEG-4 VIDEO THAT 
WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR 
WAS OBTAINED FROM A VIDEO PROVIDER LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER 
USE. ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, INTERNAL AND 
COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG LA, LLC. SEE HTTP://
WWW.MPEGLA.COM.

MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF 
A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE REMUNERATION TO (i) ENCODE VIDEO 
IN COMPLIANCE WITH THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS 
ENCODED BY A CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A 
VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED 
FOR ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.

MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE FOR 
ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT AN ADDITIONAL 
LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR ENCODING IN CONNECTION WITH (i) DATA 
STORED OR REPLICATED IN PHYSICAL MEDIA WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) 
DATA WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR 
PERMANENT STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.

Limited Warranty and Disclaimers
Telestream, LLC (the Company) warrants to the original registered end user that the product will 
perform as stated below for a period of one (1) year from the date of shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment supplied but 
not manufactured by the Company but NOT including any third party equipment that has been 
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substituted by the Distributor for such equipment (the “Hardware”), will be free from defects in 
materials and workmanship under normal operating conditions and use.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any defective Hardware 
component or part, or Software Media, with new or like new Hardware components or Software Media. 
Components may not be necessarily the same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if any, Telestream is 
under no obligation to maintain or support the Software and Telestream has no obligation to furnish 
you with any further assistance, technical support, documentation, software, update, upgrades, or 
information of any nature or kind.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or Software Media, 
or any part thereof, is damaged due to abuse, misuse, alteration, neglect, or shipping, or as a result of 
service or modification by a party other than the Company, or (ii) Software is modified without the 
written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY WARRANTIES OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE. No oral or written information or advice given by the Company, 
its distributors, dealers or agents, shall increase the scope of this Limited Warranty or create any new 
warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the country in which 
the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF TELESTREAM, 
LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS LIMITED WARRANTY. Your sole and 
exclusive remedy for any and all breaches of any Limited Warranty by the Company shall be the 
recovery of reasonable damages which, in the aggregate, shall not exceed the total amount of the 
combined license fee and purchase price paid by you for the Product. 

Damages
TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS, 
LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR USE OR 
INABILITY TO USE THE PRODUCT, OR THE BREACH OF ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF 
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THE COMPANY HAS BEEN ADVISED OF THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY 
PROVIDED FAILS OF ITS ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, LLC
848 Gold Flat Road
Nevada City, CA 95959 USA

You can call Telestream during U. S. business hours via telephone at (530) 470-1300.

Regulatory Compliance
Electromagnetic Emissions: FCC Class A, EN 55022 Class A, EN 61000-3-2/-3-3, CISPR 22 Class A

Electromagnetic Immunity: EN 55024/CISPR 24, (EN 61000-4-2, EN 61000-4-3, EN 61000-4-4, EN 61000-
4-5, EN 61000-4-6, EN 61000-4-8, EN 61000-4-11)

Safety: CSA/EN/IEC/UL 60950-1 Compliant, UL or CSA Listed (USA and Canada), CE Marking (Europe)

California Best Management Practices Regulations for Perchlorate Materials:
This Perchlorate warning applies only to products containing CR (Manganese Dioxide) Lithium coin 
cells. Perchlorate Material-special handling may apply. See www.dtsc.ca.gov/hazardouswaste/
perchlorate.
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Introduction
Nagra’s NexGuard video and audio watermarking products are employed in post-
production systems to provide forensic, video, and audio watermarking, making media 
copies traceable and secure throughout the dubbing, review, preview, and distribution 
processes. Embedded forensic marking deters piracy by ensuring traceability of 
individual copies, even during tape or DVD duplication, transfer, and transcoding. 

Telestream integrates NexGuard Embedder (deprecated), NexGuard Transcoder Plugin, 
and NexGuard Streaming products in Vantage as an optional, licensed feature so that 
media owners can protect content by identifying unique copies of their material 
utilizing NexGuard as part of their normal workflow processing using any Vantage 
transcoder—on-premises and in Telestream Cloud—efficiently and flexibly. 

Topics
■ Overview

■ NexGuard Watermarking Implementation

■ Getting Started with NexGuard Watermarking

Note: This guide is written for video professionals who are familiar with using 
Vantage. To implement media processing applications in Vantage, you should know 
how to create and configure workflows and submit jobs. If you aren’t familiar with 
Vantage, Telestream suggests that you review the Vantage User’s Guide and Vantage 
Domain Management Guide as needed.
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Overview
Vantage integrates Nagra’s NexGuard Embedder (deprecated), NexGuard Transcoder 
Plugin, and NexGuard Streaming watermarking products in several Vantage 
transcoding actions. Vantage workflows using NexGuard Embedder, which is 
implemented in the NexGuard Watermark Filter and NexGuard Transcoder Plugin, 
implemented in NexGuard Watermark (JWT License) Filter, can also interact with 
NexGuard Manager to dynamically obtain watermark identifiers and update job status 
and metadata from Vantage media processing jobs.

This diagram illustrates how media is typically ingested from a media server for 
transcoding in Vantage using a Flip64 transcoding action, where NexGuard 
watermarking is applied.

Vantage Domain

Media
Storage

Broadcast Server
Input
media

Transcoded,
watermarked
media

Vantage Transcoding Workflow
(Flip | Flip64 | IPTV VOD | Multiscreen Flip | Conform)

The Flip64 action depicted here is configured to transcode media with the video stream 
watermarked by NexGuard Embedder—via the NexGuard Watermark Filter—and then 
delivered to a broadcast server. 

Note: Whether you have a single-server Vantage domain or a multi-server Vantage 
domain (an array), the functionality is identical. In an array, Vantage services are 
deployed on multiple servers to scale concurrent job execution. You may also utilize 
Vantage Cloud, where supported transcoding actions can execute in the Cloud.
NexGuard Integration Guide
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NexGuard Watermarking Implementation
NexGuard watermarking products are implemented in many Vantage transcoding 
actions, as shown in this table.

NexGuard Manager, if installed in your environment, may also be integrated into 
workflows and utilized by the Notify action to exchange metadata on a job-by-job 
basis.

Vantage NexGuard Watermarking Filters and Nagra NexGuard Products

Vantage 
Transcoding 
Actions

NexGuard 
Watermark Filter—
NexGuard 
Embedder 
(Deprecated) 
(Video & Audio*)

NexGuard 
Watermark (JWT 
License) Filter—
NexGuard 
Transcoder
(Video Only)

NexGuard 
Streaming 
Watermark Filter—
NexGuard 
Streaming
(Video Only)

 Flip

 Flip64 

 Flip64
(Cloud 
Mode)

 Multiscreen

 Multiscreen
(Cloud 
Mode)

 IPTV Flip

 IPTV Flip
(Cloud 
Mode)

 Conform 
Video Only

 

In order to watermark media in a given transcoding action, the codec you select must 
not be operating in direct-convert mode. To perform watermarking, the media must be 
decoded down to digital baseband and re-encoded—transcoded, or flipped—using 
Vantage vernacular. Also, some video and audio formats (legacy formats, or AC-3 for 
example) can’t be watermarked in Vantage.

NexGuard Embedder (Deprecated)
NexGuard watermarking by NexGuard Embedder was implemented in Vantage version 
4.0 and continues to be included in Vantage 8.0 UP4 and later for backward 
compatibility. NexGuard Embedder is implemented by the NexGuard Watermark Filter 
in these actions: 
NexGuard Integration Guide
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• Flip action (video and audio) 

• Flip64 action on-premises (video and audio) 

• Conform action on-premises (video only)

• IPTV VOD action on-premises (video and audio)

NexGuard Embedder requires the NexGuard SafeNet license or the NexGuard SafeNet 
Floating license from Nagra.

NexGuard Transcoder Plugin
NexGuard Transcoder Plugin is implemented by the NexGuard Watermark (JWT 
License) Filter in these Vantage actions: 

• Flip64 action on-premises

• Flip64 action in Cloud mode

• IPTV Flip action on-premises

• IPTV Flip action in Cloud mode

• Conform action on-premises

NexGuard Transcoder Plugin requires the NexGuard JWT license from Nagra.

NexGuard for Streaming
NexGuard for Streaming is implemented by the NexGuard Watermark (JWT License) 
Filter in these actions:

• Multiscreen Flip action on-premises

• Multiscreen Flip action in Cloud mode

NexGuard for Streaming requires the NexGuard JWT license from Nagra.
NexGuard Integration Guide
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Getting Started with NexGuard Watermarking
Follow these guidelines to get started using NexGuard to watermark your media in 
Vantage:

1. Verify that Vantage is installed and meets the minimum version requirements, and 
update Vantage as required—proceed to Vantage Requirements.

2. If you plan to use Nagra NexGuard Manager, make sure that it is installed and 
licensed—proceed to Exchanging Job Metadata with NexGuard Manager.

3. Obtain and apply the appropriate Telestream and NexGuard licenses—proceed to 
Obtaining & Applying Vantage & NexGuard Licenses.

4. Jump into the Implementing NexGuard Watermarking in Workflows when you’re 
ready to start building workflows that use NexGuard to watermark your media.
NexGuard Integration Guide
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Enabling NexGuard 
Products in Vantage
Nagra’s NexGuard Embedder, Transcoder Plugin, and NexGuard for Streaming 
watermark products are integrated directly into Vantage and do not require 
installation.

You should verify that your Vantage domain meets version requirements, and obtain 
and apply licenses from both firms to begin watermarking your media using NexGuard. 

Topics
■ Vantage Requirements

■ NexGuard Manager Requirements

■ Obtaining & Applying Vantage & NexGuard Licenses
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Vantage Requirements
Before you can use Nagra NexGuard products in your Vantage workflows, your Vantage 
domain should be installed and operating at these minimum version levels or later:

• Vantage 8.0

• Vantage 8.0 Update Packs

–  Update Pack 4

• GP Transcoder 2019.1—required for Flip actions

• ComponentPacs:

– Flip64 8.0.9—required for Flip64 actions

– IPTV VOD 8.0.6—required for IPTV Flip actions

– Multiscreen 8.0.7—required for Multiscreen Flip actions

– Post Producer 2022.1—required for Conform actions.

Installation instructions are included for each product, Update Pack, and 
ComponentPac in associated documentation.

For information about downloading Vantage installers, Update Packs and 
ComponentPacs, please contact Telestream Support at support@telestream.net. 

You can also view Vantage support information by visiting https://www.telestream.net/
telestream-support/overview.htm.

See Contacting Telestream for other ways to communicate with Telestream.

NexGuard Manager Requirements
NexGuard Manager Version 1 (deprecated) and Version 2 are supported in Vantage for 
use in NexGuard Watermark filters, which implement NexGuard Embedder, and 
NexGuard Watermark (JWT License) filters, which implement NexGuard Transcoder 
Plugin.

NexGuard Manager may be integrated into on-premises and hybrid workflows. 

In a hybrid workflow, when a transcoding action is operating in Cloud mode—where 
the action may execute in Telestream Cloud—you can configure Notify actions on-
premises to pass metadata between NexGuard Manager and the transcoder action 
executing in Telestream Cloud.

Note: NexGuard Manager can not be used with the NexGuard Watermark (JWT 
License) Filter (NexGuard Transcoder Plugin) in hosted workflows or with the 
NexGuard Streaming Watermark Filter (NexGuard for Streaming).

For an implementation overview, see Exchanging Job Metadata with NexGuard Manager.
NexGuard Integration Guide
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Version 1 (Deprecated)
To utilize NexGuard Manager Version 1, it must be licensed, and the server hosting it 
must be accessible by all Vantage nodes that implement NexGuard watermarking. 
NexGuard Manager must also be accessible from nodes in the domain where the 
Vantage Communicate Service executes Notify actions. 

Note: For information about using NexGuard Manager V1 which is deprecated, 
please contact Telestream Customer Service (See Contacting Telestream).

Version 2
NexGuard Manager Version 2 must be installed on a server as a VM (independent of the 
Vantage domain). The VM must be accessible by each Vantage Communicate Service 
that executes Vantage Notify actions. The NexGuard Manager package includes a pre-
installed license. For a prototype workflow and implementation details, see Using 
NexGuard Manager.
NexGuard Integration Guide
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Obtaining & Applying Vantage & NexGuard 
Licenses

Before you can utilize NexGuard watermarking in Vantage, you should—in this order—
obtain and activate licenses from Telestream and Nagra. 

Note: If you don’t have a license from Telestream, the filters are disabled. If you don’t 
have a license from Nagra, your Vantage jobs will fail.

■ Obtaining a NexGuard Forensic Watermarking License from Telestream

■ Activating Telestream’s NexGuard Forensic Watermarking License

■ Obtaining NexGuard Licenses from Nagra 

Obtaining a NexGuard Forensic Watermarking License from 
Telestream

Utilizing NexGuard watermarking products in Vantage requires a NexGuard Forensic 
Watermarking license from Telestream. The Vantage filters that implement these 
products in supported transcode actions are disabled unless Telestream’s NexGuard 
watermarking license is installed and active.

The NexGuard Forensic Watermarking license allows you to enable and configure all 
NexGuard watermarking filters in any transcoding action executing on-premises or in 
Telestream Cloud. This license also enables communication with NexGuard Manager.

A prerequisite to the use of this license is that you also have a Vantage Transcode | 
Transcode Pro or other Vantage product license that supports NexGuard watermarking.

Note: Filter execution is only enabled when you have licenses from Nagra (see 
Obtaining NexGuard Licenses from Nagra). If you attempt to execute a job without a 
license, the job fails.

Maximum On-Premise Concurrent Watermarking Jobs
Each NexGuard Forensic Watermarking license enables four concurrent sessions of 
NexGuard video watermarking and four concurrent sessions of audio watermarking in 
a Vantage domain on-premises. For Telestream Cloud execution, concurrent job limits 
do not apply.

You can purchase additional licenses to enable additional concurrent sessions. The 
Telestream license must be paired with a Nagra license, and the maximum seats in each 
license should match.

For example, if you have a 4-seat Telestream license (4 concurrent executions), the 
domain can concurrently execute 1 Flip64, 1 IPTV VOD, 1 Conform and 1 Flip action 
simultaneously, by any transcode service on any node (server). Vantage places jobs in a 
NexGuard Integration Guide
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waiting state if all seats are being used, until one becomes available or the job times 
out and fails.

For information about Vantage licensing, contact your Telestream representative or 
contact the licensing team via email at license@telestream.net. You can also obtain 
Vantage product support by visiting https://telestream.net/telestream-support/
overview.htm. See Contacting Telestream for other ways to communicate with 
Telestream.

Activating Telestream’s NexGuard Forensic Watermarking 
License

When you purchase a NexGuard Forensic Watermarking license, Telestream sends you a 
temporary license file to enable the feature immediately (see Adding a Temporary 
License File).

On completion of the transaction, typically your permanent license is updated and a 
new license file is also generated and delivered, which you use to replace your existing 
license file (see Updating an Existing License File).

The naming pattern for Vantage license files is <MyDomain ID>-<Suffix ID>.xml; for 
example: 99999-911111.xml, where 99999 is the domain ID. Temporary license files 
repeat the domain ID, but provide a unique suffix. For example: 999999-11112.xml.

Note: See the Vantage Domain Management Guide (Help > Contents) for detailed 
license-related topics as required.

To activate the license, add it to the Vantage domain using the Vantage Management 
Console and restart all client programs—see the following topics.

Adding a Temporary License File
1. Copy the temporary license file that you received and add it to the server and 

directory where you keep your Vantage license file(s).

License files (*.xml) are typically stored in a customer-created Licenses directory: 
C:\Program Files (x86)\Telestream\Vantage\Licenses. 

However, license files may be stored anywhere that the Vantage Domain Console 
can access them.

2. Open the Vantage Domain Console, display the Licenses tab and add the new 
license.

The policies in the file are imported into the Vantage domain database where they 
can be utilized by Vantage services as they execute actions.
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Updating an Existing License File
1. Copy the license file that you received and add it to the directory where you keep 

your Vantage license file(s). To replace an existing license file, overwrite the existing 
file in the directory.

Often, license files (*.xml) are stored in a customer-created Licenses directory: 
C:\Program Files (x86)\Telestream\Vantage\Licenses.

However, license files can be stored anywhere that the Vantage Domain Console 
can access them.

2. Open the Vantage Domain Console, display the Licenses tab and add the license. 
The policies in the file are imported into the Vantage domain database.

3. Open the Vantage Domain Console, display the Licenses tab and delete the license 
whose file you just replaced. The policies in the file are deleted from the Vantage 
domain database.

4. Now, add the license. The policies in the file are imported into the Vantage domain 
database where they can be utilized by Vantage services as they execute actions.

Restarting Vantage Services and Workflow Designer
To complete the licensing of NexGuard products in Vantage, restart these Vantage 
services on each node where they are installed:

1. In the Vantage Management Console, display the Services panel

2. Select each service (control-click to select multiple) to restart:

–  Vantage Transcode Service

– Vantage Edit Service

– Vantage Multiscreen Service

– Vantage IPTV VOD Service.

3. Right-click and select Restart Service. 

The console stops the selected services and restarts them.

4. When these services indicate Online, close and restart Vantage Workflow Designer 
so that you can create and execute workflows utilizing NexGuard.

5. If you are using other Vantage client programs, close and restart them as well.
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Obtaining NexGuard Licenses from Nagra
SafeNet machine or floating licenses from Nagra are required to execute NexGuard 
Embedder (deprecated) in Vantage. 

JWT machine or floating licenses are required to execute NexGuard Transcoder Plugin 
and NexGuard Streaming products in Vantage. 

To obtain NexGuard licenses, please contact your Nagra representative directly. For 
NexGuard licensing or technical support, contact Nagra via email at 
NexGuardCustomerCare@nagra.com.

Note: For information about executing concurrent watermarking jobs, see Maximum 
On-Premise Concurrent Watermarking Jobs.

Nagra’s NexGuard licenses are not part of a Vantage domain—however, Nagra licenses 
must be stored in specific folders to be accessible to Vantage services using NexGuard 
filters to watermark media.

After purchasing the required licenses, Nagra will provide you the license files and 
instructions for installation. You may receive one or more license files, based on your 
server requirements.
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Exchanging Job Metadata 
with NexGuard Manager
Vantage supports integration with NexGuard Manager Version 1 and NexGuard 
Manager Version 2. NexGuard Manager is a licensed, optional product from Nagra (see 
Obtaining NexGuard Licenses from Nagra). 

Note: This chapter describes the use of NexGuard Manager V2. For information about 
using NexGuard Manager V1 which is deprecated, please contact Telestream 
Customer Service (See Contacting Telestream).

You can use NexGuard Manager in Vantage Flip, Flip64, IPTV Flip, and Conform 
workflows that utilize the NexGuard Watermark Filter (NexGuard Embedder) on 
premise or the NexGuard Watermark (JWT License) Filter (Transcoder Plugin) on-
premises or in hybrid workflows.

Note: NexGuard Manager can not be used with the NexGuard Watermark (JWT 
License) Filter (NexGuard Transcoder Plugin) in hosted workflows or with the 
NexGuard Streaming Watermark Filter (NexGuard for Streaming).

NexGuard Manager is used to provide unique watermark IDs and other metadata on a 
job-by-job basis. It is also used to update job records with metadata you supply after 
each job executes. 

Vantage workflows communicate with NexGuard Manager via a REST interface, and 
uses a Notify action configured to use the NexGuard Notifier.
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Using NexGuard Manager
This prototype workflow illustrates a simplified workflow demonstrating the basic use 
of NexGuard Manager V2. It depicts using a Flip64 action (other transcode actions, for 
example, can also be used). This workflow may not meet your requirements, and by 
necessity, should be modified to meet your requirements.

NexGuard Manager 
Start Job operation

NexGuard Manager Successful 
Update External Job operation

NexGuard Manager Failure 
Update External Job operation

Input and output values and settings are all specified in the Notify action’s NexGuard 
Notifier Inspector panels; detailed explanations and control definitions are provided by 
context-sensitive help. Click on the M button to display the help page for each panel.

This workflow includes the following actions:

Receive—enables you to drag and drop a media file directly on the Receive action in 
Workflow Designer to start each job. Other origin actions can be used (Watch | 
Workorder, etc.), based on your job submission requirements. In particular, the first 
Notify (using the Start Job operation) can send a variety of metadata to NexGuard 
Manager, which is not described in this workflow. See Methods for Providing Metadata 
for details.

Notify (Start Job)—The first Notify action is configured to use the NexGuard Notifier via 
the REST interface and credentials. The NexGuard Notifier executes a Start Job 
operation to create a job record in NexGuard Manager and obtain watermark ID and 
job ID and stored in variables you select. The key you specified is also passed 
downstream for use in other actions.

Flip64—The Flip64 action is a Vantage Cloud Port-capable, 64-bit multi-core-optimized 
encoder running under the Vantage Transcode Service (except in Cloud mode, when it 
is executed by the Telestream Cloud Service, operating as a proxy of the Transcode 
Service). It transcodes media from one format into another format as specified by the 
output configuration you specify.

Notify (Update External Job)—When transcoding and watermarking is complete, one of 
two Notify actions execute: the upper (Perform On > Success) Notify action advises 
NexGuard Manager that the job completed normally, and the job is updated in its 
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database. In the event of a transcode action failure, the Notify at the bottom (Perform 
On > Failure) notifies NexGuard Manager to update the job record with an error status.

Synchronize—The only purpose of the Synchronize is to bring all output into a single 
action for reporting purposes elsewhere in Workflow Designer.

Start Job
The Start Job operation is always executed by the Notify action prior to the Transcode 
action. When Start Job executes, NexGuard Manager creates a new job record with the 
input values provided and returns a watermark ID for use in a watermark filter:

Start Job Input
The Notify action delivers this data to NexGuard Manager to create a new job record:

Job > Work Order (optional) 

Job > Key: Keyword string; selected from one or more keys obtained from the 
license file or manually entered.

Title | Customer | Recipient fields: Recipient > Last Name is required; all other 
metadata fields are optional, per your requirements.

Start Job Output
NexGuard Manager returns this data to the Notify action for this job:

Watermark ID Integer value; unique watermark ID

Job ID Integer value; returned from NexGuard Manager.

Notify Action Output
The Notify action passes these variables for use downstream:

Key The specified variable is updated with the key you specified.

Watermark ID The specified variable is updated with the watermark ID returned 
from NexGuard Manager.

Job ID The specified variable is updated with a unique Job ID returned from Nex-
Guard Manager.

Update External Job
The Update External Job operation is always executed by one of two Notify actions 
immediately following the Transcode action, one of which must be set to Perform On > 
Success, and the other to Perform On > Failure.

When Update External Job executes, NexGuard Manager updates the job record with 
the Job ID and Status provided:
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On Success Update External Job Input
If the Transcode action completes normally, the Perform On > Success Notify action 
executes and delivers the following data to NexGuard Manager to update the specified 
job record:

Job ID (required) string in Job ID variable specified in previous Notify 

Status keyword Finished (required) 

On Failure Update External Job Input
If the Transcode action fails, the Perform On > Failure Notify action executes and 
delivers the following data to NexGuard Manager to update the specified job record:

Job ID (required) string in Job ID variable specified in previous Notify 

Status keyword Error (required) 

Configuring a Notify Action to use NexGuard Manager
Configure each Notify action as follows:

1. Open the Notify action inspector:

Select the NexGuard 
Notifier
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2. Select the NexGuard Notifier and click Next.

Workflow Designer displays the connection information panel:

NexGuard Manager 
host and port

Interface selector

Help page for this 
inspector panel

Connection Tester

NexGuard Manager 
credentials

3. Select the REST interface, enter the NexGuard Manager’s host IP | Windows Name, 
port number (typically 80), and your credentials.

4. Click Test Connection to verify that your settings are correct. If an error displays, 
correct the information and retry.

5. When Workflow Designer reports a successful connection, click Next.

Note: A successful connection in Workflow Designer validates the host, port, and 
credentials. However, the Vantage Communicate Service which executes the Notify 
action may not be able to connect, due to configuration errors, or based on its own 
Windows permissions. If you can’t connect, resolve the problem and retry.
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Configuring a Notify Action > Start Job Operation
Configure the NexGuard Manager Information panel as follows:

Key selector

Operation selector

Variables generated 
from this operation

Detailed man page help 
system for this panel

1. Select the Start Job operation.

2. In the Job category, select the key you want to use for this job. Keys are extracted 
from the NexGuard Manager license.

3. In Output Variables, specify the variables you want updated with the Key, 
Watermark ID and Job ID values. The Key is specified by you; the Job ID and 
Watermark ID are generated by NexGuard Manager. 

4. Update job metadata controls that you want to utilize, with a static value or bind it 
to a variable. All of these values are sent to NexGuard Manager to start a new job 
record and update it with this metadata, including the key you specify.

For job metadata controls (Work Order in the Job category, and all controls in the 
Title, Customer, and Recipient categories), you can supply by either manually enter-
ing the value (which is static and never changes) or by binding it to a variable so 
that you can change values on a job-by-job basis. (See Methods for Providing Meta-
data for details).

5. Click Next and then click Finish to save the Notify action’s configuration.
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Configuring a Notify Action > Update External Job on 
Success

Configure the Perform On > Success Notify action after the transcode action as follows:

Job ID field

Operation selector

Status selector

1. Select the Update External Job operation from the Select... menu.

2. Specify the Job ID by clicking the green Variable Browse button and selecting the 
variable assigned the Job ID value in the first Notify.

3. Select Finished from the Status menu to indicate that the transcode operation 
completed normally.

4. Click Next and then click Finish to save the Notify action’s configuration.

Configuring a Notify Action > Update External Job Failure
Configure the Perform On > Failure Notify action after the transcode action as follows:

Job ID field

Operation selector

Status selector

1. Select the Update External Job operation from the Select menu.

2. Specify the Job ID by clicking the green Variable Browse button and selecting the 
variable assigned the Job ID value in the first Notify.

3. Select Error from the Status menu to indicate that the transcode operation did not 
complete normally.

4. Click Next and then click Finish to save the Notify action’s configuration.
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Implementing NexGuard 
Watermarking in Workflows
There are several Nagra products—and several methods and features—that you can 
use to watermark your media with NexGuard products in Vantage, depending on your 
media post-production and watermarking requirements. For example, you can 
watermark media in on-premise workflows as well as hybrid workflows where 
transcoder actions execute in Cloud mode, or in hosted workflows, where the entire 
workflow is exported for deployment in Telestream Cloud. In addition, you can use 
NexGuard Manager in workflows to improve dynamic metadata utilization.

This chapter discusses topics that apply generally to watermarking your media in 
Vantage using NexGuard. The remaining chapters are dedicated to the use of NexGuard 
watermarking in the context of specific transcoding actions.

Topics
■ Overview

■ Providing Input Values Dynamically

■ Methods for Providing Metadata
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Overview
Vantage implements NexGuard watermarking in Flip | Flip64 | Multiscreen Flip | IPTV 
Flip | Conform actions. For details, see NexGuard Watermarking Implementation.

The minimum workflow required to utilize NexGuard products in a workflow is an 
origin action to suit your workflow requirements, and a transcode action that supports 
NexGuard—Flip | Flip64 | Multiscreen | IPTV | Conform. 

When you’re using NexGuard Manager, you can exchange and deliver metadata on a 
job-by-job basis to update your records: providing a unique watermark ID and key and 
returning job results to NexGuard Manager. For details, see Exchanging Job Metadata 
with NexGuard Manager. Communication with NexGuard Manager is performed using 
the Notify action in on-premises and hybrid workflows.

Of practical necessity of course, your workflow should be designed and implemented 
to meet your operational and transcoding requirements and may include many other 
actions, not necessarily associated with NexGuard watermarking. In many cases, a very 
comprehensive (and thus, complex) workflow may simply include NexGuard 
watermarking as one of the many tasks being performed, not as the primary one.

The workflows in this guide use a Receive action to start each workflow, so that you can 
just browse for a file or drop one on the workflow to execute it. Other origin actions (for 
example, Watch or Workorder) may also be used, depending on your job submission 
requirements.

Watermarking of course, can’t be performed when the transcoder is operating in direct-
convert mode; the media must be decoded down to digital baseband and re-encoded 
to be watermarked. Downstream transcoding and other Vantage processing does not 
alter the watermark once it is applied to the media.

Video watermarking can be performed on media being processed by any codec which 
creates a series of frames in a stream or during any process where the codec is 
encoding new frames. For example, key frame encoding doesn’t support watermarking 
because it is not making a series of frames in a stream.

Likewise, audio watermarking can be performed on media being processed by any 
codec which encodes/re-encodes a new audio stream.

Minimum time limits on media may apply; they are noted in appropriate topics.

Note: Online help is available in Workflow Designer as you configure an action. 

Help toolbar



In each action’s inspector, a help toolbar displays in the upper right corner. Click the R 
button to locate and display a read-only reference inspector of any workflow’s action. 
Click the M button to display context-sensitive help. The help (man) page describes 
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each component in detail, including controls. Click the ? icon to display the Workflow 
Designer User’s Guide > Configuring Actions topic for general assistance.

Providing Input Values Dynamically
NexGuard Manager is used to provide watermark input parameters and receive job 
reports from your workflows that use the NexGuard Watermark Filter or the NexGuard 
Watermark (JWT License) Filter, on a job-by-job basis. The method is described in 
Exchanging Job Metadata with NexGuard Manager.

You can provide unique watermark IDs and keys and other metadata values 
dynamically to the NexGuard Watermark filter and the NexGuard Watermark (JWT 
License) filter if you aren’t using NexGuard Manager (or it is temporarily unavailable) to 
perform the task automatically.

NexGuard watermark filters provide controls in the action inspector to provide the 
required input values. If you want to use the same watermark ID or other input value for 
each job, you can just enter or select the value statically.

However, if the values change each job, you must manually update them in the filter 
each time before submitting a job. However, this manual process can be time-
consuming and ineffective.

To automate providing input values, you can bind the controls to variables where 
values change on a job-by-job basis.

Metadata requirements for NexGuard filters are based on the implemented Nagra 
product and the Vantage action it’s implemented in:

Flip Action
NexGuard Watermark Filter (NexGuard Embedder)—video and audio:

• Watermark ID

• Watermark Key

Flip64 Action
NexGuard Watermark Filter (NexGuard Embedder)—video and audio:

• Watermark ID

• Watermark Key

NexGuard Watermark (JWT License) Filter (NexGuard Transcoder Plugin)—video: 

• Watermark ID

• Preset Name

• Watermark Strength keyword

• Cloud Deployment License string, when executing in Cloud Mode
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Conform Action
NexGuard Watermark Filter (NexGuard Embedder)—video:

• Watermark ID

• Watermark Key

NexGuard Watermark (JWT License) Filter (NexGuard Transcoder Plugin)—video: 

• Watermark ID

• Preset Name

• Watermark Strength keyword

• Cloud Deployment License string, when executing in Cloud Mode

Multiscreen Flip Action
NexGuard Streaming Watermark Filter (NexGuard for Streaming)—video

• Watermark ID

• Preset Name

• Watermark Strength keyword

• Cloud Deployment License string, when executing in Cloud Mode

IPTV Flip Action
NexGuard Watermark Filter (NexGuard Embedder)—video and audio:

• Watermark ID

• Watermark Key

NexGuard Watermark (JWT License) Filter (NexGuard Transcoder Plugin)—video:

• Watermark ID

• Preset Name

• Watermark Strength keyword

• Cloud Deployment License string, when executing in Cloud Mode
NexGuard Integration Guide



Implementing NexGuard Watermarking in Workflows 
Methods for Providing Metadata

39
Methods for Providing Metadata
Here are several ways you can use variables to dynamically supply metadata values on a 
job-by-job basis: For these options, configure the filters to use specific variables for the 
watermark ID and key (and others) instead of entering static values, and then:

• Supply values in the file name—use a Construct action to create a string variable 
with the file name—for example: CascadeSnow_12345_Key1.mov—where the 
watermark ID and key are part of the name—and then use a Compute action to 
extract the ID (or other input value) into a variable, for use in the filter control for 
the corollary metadata.

• Supply the media file and values in a workorder—Create a workorder schema 
for a CSV file, where each row represents a job, and specifies the file path and other 
input values required, and use a Workorder action as the origin action in your work-
flow, to start a job for each line item and generate variables for use in the transcode 
action’s watermark filter. (Workorders enable you to submit multiple jobs at one 
time.)

• Use Workflow Portal to select media and enter values—Create a Workflow Por-
tal configuration that enables operators to provide input values and browse and 
select the media file to submit. Workflows intended for job submission via Work-
flow Portal must start with a Receive action.

• Supply values in an attachment—provide the values in a JSON or XML file and 
configure your workflow with a Watch configured for an attachment or a Watch 
with an Associate action; extract the values using an Extract action for use in the 
transcode action or other actions in the workflow. 

• Create your own program—Using the Vantage SDK, create a simple job submis-
sion program, where operators select an input file, enter the required input values, 
and submit the job to a workflow. Workflows intended for job submission via a pro-
gram must start with a Receive action. The Receive action must be configured to 
receive the variables you are including with the job—right-click and select Add 
Variables—and enter each variable you plan to supply. 
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Configuring Flip64 Actions 
for Watermarking
The Flip64 action includes filters for watermarking using two different NexGuard 
products—NexGuard Embedder (deprecated) which watermarks video and audio and 
NexGuard Transcoder Plugin—which watermarks video on-premises as well as in 
hybrid and hosted workflows executing in Telestream Cloud. 

Before creating NexGuard watermarking workflows for a particular transcoding action, 
Telestream recommends that you read Implementing NexGuard Watermarking in 
Workflows, where you’ll learn about issues that apply generally to watermarking your 
media in Vantage using NexGuard. 

Topics
■ Overview

■ Creating a Prototype Workflow

■ Configuring the Video NexGuard Watermark Filter

■ Configuring the Audio NexGuard Watermark Filter

■ Configuring the NexGuard Watermark (JWT License) Filter in On-Premise Workflows

■ Configuring the NexGuard Watermark (JWT License) Filter in Hybrid Workflows

■ Configuring the NexGuard Watermark (JWT License) Filter in Hosted Workflows
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Overview
The Flip64 action implements two NexGuard filters:

• NexGuard Watermark Filter—implements NexGuard Embedder (deprecated), for 
execution on-premises only; watermarks video and audio streams in separate fil-
ters. Supports use of NexGuard Manager.

• NexGuard Watermark (JWT License) Filter—implements the NexGuard Transcoder 
Plugin, executes on-premises and in hybrid when the Flip64 action is configured to 
operate in Cloud mode or the workflow is a hosted workflow, which executes 
entirely in Telestream Cloud. Supports the use of NexGuard Manager in on-premise 
and hybrid workflows.

Flip64 workflows with NexGuard watermarking have the following limits/requirements:

• You can’t watermark media in formats that don’t support watermarking.

• Watermarking can’t be performed with codecs being used in Direct-Convert mode; 
they must decode and re-encode the video/audio.

• The video must be at least 2 1/2 minutes long for the watermark to be detected. For 
audio, clips must be at least 15 seconds long.

• Audio watermarking is supported for PCM and AAC audio. If you want water-
marked audio in another format, first watermark PCM, then re-encode it in your 
required format; watermarking is preserved.
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Creating a Prototype Workflow
This is a basic Flip64 workflow that you can use to watermark your media during 
transcoding. 

This workflow includes the following actions:

Receive—enables you to drag and drop a media file directly on the Receive action in 
Workflow Designer to start each job. Any other origin action can be used (Watch | 
Workorder, etc.), based on your job submission requirements.

Flip64—the Flip64 action is a Vantage Cloud Port-capable, 64-bit multi-core-optimized 
encoder running under the Vantage Transcode Service (except in Cloud mode, when it 
is executed by the Telestream Cloud Service, operating as a proxy of the Transcode 
Service). It transcodes media from one format into another format as specified by the 
output configuration you specify.

If you use NexGuard Manager, see Exchanging Job Metadata with NexGuard Manager for 
implementation details.

If you are using a Nagra machine license, you should add a run-on rule to the 
transcoding action and configure it to execute on the server where the license is 
installed. See the Workflow Designer User’s Guide for details.

Note: Detailed online help is provided in Workflow Designer for use when you are 
configuring an action. Double-click an action to display its inspector, where you can 
press click the M button to display the man page, which describes each component in 
detail, including controls.

Follow these steps to create your prototype Flip64 workflow:

1. In Workflow Designer, create a new category to store your NexGuard workflows. For 
example, NexGuard Flip64 Workflows.

2. Create a new workflow: Flip64 Prototype Watermark, for example.

3. Add a Receive action, and configure it to ingest a media file—select Original as the 
nickname.
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4. Now, add a Flip64 action and configure these settings:

– Inputs: Add an Auto input and select Original as the source file to ingest.

– Converters: No converters are required.

– Outputs: Add an MPEG-4 container and specify the output nickname as Out. For 
video, specify the x264 codec, and for audio, the AAC codec.

5. Optionally, configure remaining settings—other than the NexGuard Watermark 
filters—as desired.

When you are using a machine license from Nagra, you should add a run-on rule to the 
transcoding action and configure it to execute on the server where the license is 
installed. See the Workflow Designer User’s Guide for details.

Now, you can use this prototype workflow as a starting point to implement 
watermarking in Flip64, executing on-premises, in hybrid, and in hosted workflows, as 
described in the following topics.

In production, you can use any supported input you require, add converters, and 
generate output using any supported container/codec. The prototype is just an 
example—you can modify the workflow by adding other actions to suit your media 
processing requirements.
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Configuring the Video NexGuard Watermark Filter
The NexGuard Watermark Filter implements NexGuard Embedder in the Flip64 output 
video component for watermarking to the video stream, when executing on-premises.

Follow these steps to enable and configure it:

1. First, duplicate the Flip64 Prototype Watermark workflow, renaming it as Flip64 
Video Watermark, for example. Workflow Designer selects and opens it.

2. Open the Flip64 action’s inspector and select the MPEG-4 (or other) output’s video 
component:

Output Video 
Stream 
Component

The inspector displays its configuration panel to the right.

Watermark filter 
controls

NexGuard 
Watermark Filter

Help page for this 
inspector panel
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3. In the Video Processor settings, enable the NexGuard Watermark Filter:

The filter requires a watermark ID and watermark key. There are three ways to pro-
vide these values:

– Statically, by specifying them manually, which remain the same for every job.

– Dynamically, via variables—see Providing Input Values Dynamically.

– Using NexGuard Manager—see Exchanging Job Metadata with NexGuard 
Manager.

4. Configure these settings:

NexGuard Watermark ID. Specifies the watermark (payload) ID that NexGuard 
should use to generate the watermark. If you aren’t using NexGuard Manager or it is 
temporarily unavailable, provide the watermark ID statically or populate and select 
the variable.

NexGuard Watermark Key. Specifies the key to use when NexGuard applies the 
watermark. Select from the list in the menu.

Note: When you are using a machine license in the \Vantage directory on one 
server in an array, a race condition may occur where an unlicensed transcode 
service updates the Vantage database with licensing information after the 
licensed transcoder service has already done so. In this situation, the NexGuard 
Watermark filter won’t be able to populate the Watermark Key field, requiring you 
to add it manually.

If the NexGuard Watermark Key is a text field displaying the value Key 1, it means 
that the service was unable to access the license file or that the license information 
was updated by an unlicensed transcode service. Verify that the license file is valid 
and in the correct directory, restart the transcode service, and then retry. 

NexGuard HDR Support. When checked, enables High Dynamic Range support.

Transfer Characteristics. Specifies [Linear Gamma Corrected | DPX Cineon | Hybrid 
Log Gamma | Perceptual Quantizer]. DPX Cineon can only be used with an RGB10 
stream.

5. Now that you’ve configured the NexGuard Watermark Filter, close the inspector to 
update the action.

6. Activate the workflow, and submit a test file to start a job.

7. When the job completes, display the Job Status tab and select the job to play and 
test your watermarked media.
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Configuring the Audio NexGuard Watermark Filter
The NexGuard Watermark Filter implements NexGuard Embedder in the Flip64 output 
audio component to watermark the audio stream, when executing on-premises:

1. First, duplicate the Flip64 Prototype Watermark workflow, renaming it as Flip64 
Audio Watermark, for example. Workflow Designer selects and opens it.

2. Open the Flip64 action inspector and select the MPEG-4 (or other) output’s audio 
component:

Audio Stream 
Component

The inspector displays its configuration panel to the right.

Watermark filter 
controls

NexGuard 
Watermark Filter
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3. In the Settings panel, enable the NexGuard Watermark Filter:

The filter requires a watermark ID and watermark key. There are three ways to pro-
vide these values:

– Statically, by specifying them manually, which remain the same for every job.

– Dynamically, via variables—see Providing Input Values Dynamically.

– Using NexGuard Manager—see Exchanging Job Metadata with NexGuard 
Manager.

4. Configure these settings:

NexGuard Watermark ID. Specifies the payload ID that NexGuard should use to 
generate the watermark. If you aren’t using NexGuard Manager or it is temporarily 
unavailable, provide the watermark ID statically or populate and select the variable.

NexGuard Watermark Key. Specifies the key to use when NexGuard applies the 
watermark. You must provide the key statically or populate and select the variable. 

Note: When you are using a machine license in the \Vantage directory on one 
server in an array, a race condition may occur where an unlicensed transcode 
service updates the Vantage database with licensing information after the 
licensed transcoder service has already done so. In this situation, the NexGuard 
Watermark filter won’t be able to populate the Watermark Key field, requiring you 
to add it manually.

5. Now that you’ve configured the NexGuard Watermark Filter, close the inspector.

6. Activate the workflow, and submit a test file to start a job. 

7. When the job completes, display the Job Status tab and select the job to play and 
test your watermarked media.
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Configuring the NexGuard Watermark (JWT 
License) Filter in On-Premise Workflows

The NexGuard Watermark (JWT License) Filter implements NexGuard Transcoder Plugin 
in the Flip64 output video component to watermark the video stream.

Follow these steps to enable and configure the filter:

1. First, duplicate the Flip64 Prototype Watermark workflow, renaming it as Flip64 
Transcoder JWT Watermark, for example. Workflow Designer selects and opens it.

2. Open the Flip64 action inspector and select the MPEG-4 output video component:

Video 
Stream 

The inspector displays its configuration panel to the right.

Watermark filter 
controls

NexGuard Video 
Watermark (JWT License) 
Filter

Help page for this 
inspector panel
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3. In the Settings panel, enable the NexGuard Watermark (JWT License) Filter.

The filter requires a watermark ID, preset name, and NexGuard watermark strength 
value. There are three ways to provide these values: 

– Statically, by specifying them manually, which remain the same for every job.

– Dynamically, via variables—see Providing Input Values Dynamically.

– Using NexGuard Manager—see Exchanging Job Metadata with NexGuard 
Manager. 

4. Configure these settings:

NexGuard Watermark ID. Specifies the payload ID that NexGuard should use to 
generate the watermark. If you aren’t using NexGuard Manager or it is temporarily 
unavailable, provide the watermark ID statically or populate and select the variable.

Note: If your preset name (key) is a clip mark key, the value range for watermark 
ID is 1-1024. If you supply a key larger than 1024, the job fails with an out of range 
error.

Preset Name. Specifies the preset name to use when NexGuard applies the water-
mark. Provide the name statically or dynamically. The preset name (key) is provided 
to you by Nagra when you obtain a license.

NexGuard Watermark Strength. Specifies the level of watermarking to apply.

Note: Nagra recommends leaving the watermark strength level set to Default 
unless otherwise instructed. Application of modified values requires licensing 
updates and specific, case-by-case instructions from Nagra.

Watermark License String for Cloud Deployment. Disabled by default for execu-
tion on-premises.

5. Now that you’ve configured the NexGuard Watermark (JWT) Filter, close the 
inspector.

6. Activate the workflow, and submit a test file to start a job. 

7. When the job completes, display the Job Status tab and select the job to play and 
test your watermarked media.
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Configuring the NexGuard Watermark (JWT 
License) Filter in Hybrid Workflows

The NexGuard Watermark (JWT License) Filter in the Flip64 output video component 
implements the NexGuard Transcoder Plugin for watermarking the video stream.

The NexGuard Watermark (JWT License) Filter may be executed in on-premise 
workflows and in transcoding actions operating in Cloud mode. You can't execute the 
Notify action in Cloud mode, but you can execute it on-premises to interchange 
metadata with NexGuard Manager.

Note: If you haven’t set up your Vantage domain for operating in Telestream Cloud, 
you should do so before proceeding. For Telestream Cloud and Vantage integration 
guidance, licensing, and details on using hybrid and hosted workflows in Telestream 
Cloud, refer to the Vantage Cloud Port User Guide on our web site.

With your Vantage domain configured to integrate with Telestream Cloud, follow these 
steps to configure Flip64 to execute in Cloud mode:

1. First, duplicate the Flip64 Prototype Watermark workflow, renaming it as Flip64 
Cloud Watermark, for example. Workflow Designer selects and opens it.

2. Right-click on the Flip64 action and select Cloud Mode > Configure Cloud Mode. 
Workflow Designer displays the Configure Cloud Mode dialog:

Note: If Workflow Designer displays a Cloud Mode error dialog, verify that 
workflows can operate as hybrid or hosted workflows. Also make sure you have 
added a Vantage Cloud Port account in the Vantage Management Console—
Settings & Options > Telestream Cloud—and retry.
NexGuard Integration Guide

https://telestream.net/telestream-support/vantage-cloud-port/support.htm


Configuring Flip64 Actions for Watermarking
Configuring the NexGuard Watermark (JWT License) Filter in Hybrid Workflows

52 
3. Configure the following settings:

Enable Vantage Cloud Port Mode. Check to enable this action to execute in 
Telestream Cloud, independently of other actions in the workflow.

Select the Telestream Cloud Account. Specifies the Telestream Cloud account to 
utilize, which must be specified in the Vantage Management Console (Settings & 
Options > Telestream Cloud).

Select Cloud Storage to Utilize. Specifies the cloud storage bucket to utilize, 
which must be specified as an address in the Vantage Folder Address Book.

Note: The folder you create in the Vantage Folder Address Book must use exactly 
the same name as the storage you identify in the Telestream Cloud account. This is 
required to provide translation of the signed URL specifying the location of the 
cloud-stored media to a Vantage native URL usable by the subsequent action. 
If matching entries are not included in the Vantage Folder Address Book, the URL 
translation does not occur, and downstream actions may fail. See Adding your 
Cloud Storage Account to the Vantage Folder Address Book for additional 
configuration details.

Specify Subfolder Path in Storage. Specifies an optional subfolder (bucket) path 
to use when writing files. May be statically specified and/or variables, date and time 
tokens may be applied.

4. Now, enable and configure the filter—open the Flip64 action inspector and select 
the MPEG-4 output’s video component:

Video Stream 
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The inspector displays its configuration panel to the right.

Watermark filter 
controls

NexGuard Video 
Watermark (JWT License) 
Filter

Help page for this 
inspector panel

5. In the Settings panel, enable the NexGuard Watermark (JWT License) Filter:

The filter requires a watermark ID, preset name, NexGuard watermark strength 
value, and a license string—here shown bound to a variable. There are three ways 
to provide these values:

– Statically, by specifying them manually, which remain the same for every job.

– Dynamically, via variables—see Providing Input Values Dynamically.

– Using NexGuard Manager—see Exchanging Job Metadata with NexGuard 
Manager.

6. Configure these settings:

NexGuard Watermark ID. Specifies the payload ID that NexGuard should use to 
generate the watermark. If you aren’t using NexGuard Manager or it is temporarily 
unavailable, provide the watermark ID statically or populate and select the variable.

Note: If your preset name (key) is a clip mark key, the value range for watermark 
ID is 1-1024. If you supply a key larger than 1024, the job fails with an out of range 
error.

Preset Name. Specifies the preset name to use when NexGuard applies the water-
mark. Provide the name statically or dynamically. The preset name (key) is provided 
to you by Nagra when you obtain a license.

NexGuard Watermark Strength. Specifies the level of watermarking to apply. 
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Note: Nagra recommends leaving the watermark strength level set to Default 
unless otherwise instructed. Application of modified values requires licensing 
updates and specific, case-by-case instructions from Nagra.

Watermark License String for Cloud Deployment. Enable this control to execute 
in Telestream Cloud and supply a license string. Open the cloud license file pro-
vided by Nagra in a text editor: Select All > Copy > Paste the license string into the 
field. Alternatively, bind to a variable. For efficiency, you can create a variable in the 
Vantage Management Console, update it with the license string, and then assign 
the variable to this control. Do not use the cloud license when executing the 
transcode action on-premises.

7. Now that you’ve configured the NexGuard Watermark (JWT) Filter, close the 
inspector.

8. Activate the workflow, and submit a test file to start a job.

9. When the job completes, display the Job Status tab and select the job to play and 
test your watermarked media.
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Configuring the NexGuard Watermark (JWT 
License) Filter in Hosted Workflows

The NexGuard Watermark (JWT License) Filter in the Flip64 output video component 
implements the NexGuard Transcoder Plugin to watermark the video stream.

Watermarking with the NexGuard Transcoder Plugin may be performed in on-premise 
workflows, and it may also be performed in transcoding actions executing in 
Telestream Cloud.

This topic describes configuring the action and the filter to execute in a hosted 
workflow—where the workflow is created and configured in Workflow Designer—then 
exported as a CWD file and then imported into Telestream Cloud for execution.

It isn’t necessary to enable Cloud mode on the transcoding/media processing actions. 
The entire workflow (when imported) executes in Telestream Cloud and the Cloud 
mode settings are configured directly in Telestream Cloud, instead of the action itself.

Changes you make to the prototype workflow must be made within the limits of 
hosted workflow restrictions. 

Note: Unlike the hybrid workflow requirement, you are not required to set up your 
Vantage domain for integration with Telestream Cloud to create and export hosted 
workflows. For Telestream Cloud and Vantage integration guidance, licensing, and 
limits and details on creating and configuring hybrid and hosted workflows, refer to 
the Vantage Cloud Port User Guide on the web site.

Follow these steps to configure Flip64 to execute in a hosted workflow:

1. First, duplicate the Flip64 Prototype Watermark workflow, renaming it as Flip64 
Hosted Watermark, for example. Workflow Designer selects and opens it.

2. Because this is a hosted workflow, in order to delete temporal files, right-click on 
the action and choose Cloud Mode > Output Lifespan. 

Workflow Designer displays this dialog:

3. Select Permanent to preserve the encoded output, and close the dialog.

Now, enable and configure the filter:
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4. Open the Flip64 action inspector and select the MPEG-4 output’s video 
component:

Output 
Component

The inspector displays its configuration panel to the right.

Watermark filter 
controls

NexGuard Video 
Watermark (JWT License) 
Filter

Help page for this 
inspector panel

5. In the Settings panel, enable the NexGuard Watermark (JWT License) Filter:

The filter requires a watermark ID, preset name, NexGuard watermark strength 
value, and a license string—here shown bound to a variable. There are two ways to 
provide these values:

– Statically, by specifying them manually, which remain the same for every job.

– Dynamically, via variables—see Providing Input Values Dynamically.
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6. Configure these settings:

NexGuard Watermark ID. Specifies the payload ID that NexGuard should use to 
generate the watermark. Provide the watermark ID statically or populate and select 
the variable.

Note: If your preset name (key) is a clip mark key, the value range for watermark 
ID is 1-1024. If you supply a key larger than 1024, the job fails with an out of range 
error.

Preset Name. Specifies the preset name to use when NexGuard applies the water-
mark. Provide the name statically or dynamically. The preset name (key) is provided 
to you by Nagra when you obtain a license.

NexGuard Watermark Strength. Specifies the level of watermarking to apply. 

Note: Nagra recommends leaving the watermark strength level set to Default 
unless otherwise instructed. Application of modified values requires licensing 
updates and specific, case-by-case instructions from Nagra.

Watermark License String for Cloud Deployment. Enable this control to execute 
in Telestream Cloud and supply a license string. Open the cloud license file pro-
vided by Nagra in a text editor: Select All > Copy > Paste the license string into the 
field. Alternatively, bind to a variable. For efficiency, you can create a variable in the 
Vantage Management Console, update it with the license string, and then assign 
the variable to this control. Do not use the cloud license when executing the 
transcode action on-premises.

7. Now that you’ve configured the NexGuard Watermark (JWT) Filter, close the 
inspector to update the action.

8. Export the workflow from Workflow Designer—File > Export for Cloud.

When you export a workflow from Workflow Designer, two processes are initiated 
automatically: first, the workflow is audited to insure that it meets the criteria for a 
hosted workflow, and second, it is converted to a Compiled Workflow Document and 
saved on your local file system with a CWD extension.

With the workflow exported, your work in Vantage is complete. Follow these steps to 
import your workflow into your Telestream Cloud and process media using it:

1. Log into your Telestream Cloud account to import the CWD file and prepare it for 
deployment and execution in Telestream Cloud.

2. Using your custom submission program, submit a test file to start a job, where the 
Flip64 action executes in Telestream Cloud.

3. When the job completes, you can play and test your watermarked media.
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Configuring Multiscreen 
Flip Actions for 
Watermarking
The Multiscreen Flip action implements the NexGuard Streaming Watermark Filter, for 
watermarking video using NexGuard for Streaming. You can watermark media with 
NexGuard for Streaming in Vantage workflows executing on-premises and in 
Telestream Cloud, when the Multiscreen Flip action is executing in Telestream Cloud—
when configured for Cloud mode or as part of a hosted workflow.

Before creating NexGuard watermarking workflows for a particular transcoding action, 
Telestream recommends that you read Implementing NexGuard Watermarking in 
Workflows, where you’ll learn about issues that apply generally to watermarking your 
media in Vantage using NexGuard. 

Topics
■ Overview

■ Creating a Prototype Workflow

■ Configuring the NexGuard Streaming Watermark Filter in On-Premise Workflows

■ Configuring the NexGuard Streaming Watermark Filter in Hybrid Workflows

■ Configuring the NexGuard Streaming Watermark Filter in Hosted Workflows
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Overview
The NexGuard Streaming Watermark Filter requires an on-premise Nagra JWT license to 
execute on-premises, and a cloud-based Nagra JWT license to execute in Telestream 
Cloud. 

Nagra’s NexGuard for Streaming does not support the use of NexGuard Manager.

Multiscreen Flip action workflows with NexGuard watermarking have the following 
limits/requirements:

• You can’t watermark media in formats that don’t support watermarking.

• Watermarking can’t be performed with codecs being used in Direct-Convert mode; 
they must decode and re-encode the video.

• The minimum length of video for watermark detection varies by algorithm, as 
noted in your key name. 

- Algorithm 1 - 20 minute source required
- Algorithm 2 - 10 minute source required
- Algorithm 3 (live) and Algorithm 4(VOD) - 5 minute source required.

Note: Detailed online help is provided in Workflow Designer for use when you are 
configuring an action. Double-click an action to display its inspector, where you can 
press click the M button to display the man page, which describes each component in 
detail, including controls.
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Creating a Prototype Workflow
This is a basic Multiscreen Flip workflow that you can use to transcode, watermark and 
simultaneously package decoded digital baseband media into multiple bit-rate 
variants of H.264 and H.265/HEVC video and containers in adaptive rate streaming 
formats, including Apple HLS, Microsoft Smooth Streaming, and players that support 
MPEG DASH. 

You can modify the workflow by adding other actions to suit your media processing 
requirements.

This workflow includes the following actions:

Receive—enables you to drag and drop a media file directly on the Receive action in 
Workflow Designer to start each job. Any other origin action can be used (Watch | 
Workorder, etc.), based on your job submission requirements.

Multiscreen Flip—The Multiscreen Flip action is executed by the Vantage Multiscreen 
Service, which is used to produce high quality, industry-standard, adaptive rate 
streaming formats, including digital rights management (DRM).

Follow these steps to create your prototype Multiscreen Flip workflow:

1. In Workflow Designer, create a new category to store your test workflows. For 
example, NexGuard Multiscreen Flip Workflows.

2. Create a new workflow in this category: Multiscreen Prototype Watermark, for 
example.

3. Add a Receive action, and configure it to ingest one media file—select Original as 
the nickname.

4. Now, add a Multiscreen Flip action and configure these general settings:

– Inputs: Add an Auto input and select Original as the file to ingest.

– Converters: No converters are required.

– Transcoders: Select x264.

– Outputs: Add an Apple HLS container and specify the output nickname as out. 
Add a Fragmented MPEG-4 variant, and supply a variant name: FragMP4.

5. Optionally, configure remaining settings—other than the NexGuard Streaming 
Watermark filter—as desired. 
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When you are using a machine license from Nagra, you should add a run-on rule to the 
transcoding action and configure it to execute on the server where the license is 
installed. See the Workflow Designer User’s Guide for details.

Now, you can use this prototype workflow as a starting point to implement 
watermarking in Multiscreen Flip, executing on-premises, in hybrid, and in hosted 
workflows, as described in their respective topics.

In production, you can use any supported input you require, add converters, and 
generate output using any supported container/codec. The prototype is just an 
example—you can modify the workflow by adding other actions to suit your media 
processing requirements.
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Configuring the NexGuard Streaming Watermark 
Filter in On-Premise Workflows

The NexGuard Streaming Watermark Filter implements NexGuard for Streaming in the 
Multiscreen Flip transcoder component to apply a watermark to the video streams. 

Follow these steps to enable and configure it:

1. First, duplicate the Multiscreen Prototype Watermark workflow, renaming it as 
Multiscreen Streaming Watermark, for example. Workflow Designer selects and 
opens it.

2. Open the Multiscreen Flip inspector—select the x265 transcoder component:

x265 
Transcoder 
component 

The inspector displays its configuration panel to the right.

3. In the Settings panel, enable the NexGuard Streaming Watermark Filter:

Watermark filter 
controls

NexGuard Streaming 
Watermark Filter

Help page for this 
inspector panel

The filter requires a watermark ID, preset name, and NexGuard watermark strength 
value. There are two ways to provide these values: 

– Statically, by specifying them manually, which remain the same for every job.

– Dynamically, via variables—see Providing Input Values Dynamically.
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4. Configure these settings:

NexGuard Watermark ID. Specifies the payload ID (0 or 1) that NexGuard should 
use to generate the watermark. Provide the watermark ID statically or populate and 
select the variable.

Preset Name. Specifies the preset name to use when NexGuard applies the water-
mark. Provide the name statically or dynamically. The preset name (key) is provided 
to you by Nagra when you obtain a license.

NexGuard Watermark Strength. Specifies the level of watermarking to apply.

Note: Nagra recommends leaving the watermark strength level set to Default unless 
otherwise instructed. Application of modified values requires licensing updates and 
specific, case-by-case instructions from Nagra.

Watermark License String for Cloud Deployment. Disabled by default for execu-
tion on-premises.

5. Now that you’ve configured the NexGuard Streaming Watermark Filter, close the 
inspector to update the action.

6. Activate the workflow, and submit a test file to start a job.

7. When the workflow completes, display the Job Status tab and select the job to play 
and test your watermarked media.
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Configuring the NexGuard Streaming Watermark 
Filter in Hybrid Workflows

The NexGuard Streaming Watermark Filter implements the NexGuard Transcoder Plugin 
in the Multiscreen output video component for watermarking video streams.

Note: If you haven’t set up your Vantage domain for operating in Telestream Cloud, 
you should do so before proceeding. For guidance and details, refer to the Vantage 
Cloud Port User Guide on the Telestream website.

With your Vantage domain configured to support hybrid and hosted workflows, follow 
these steps to configure Multiscreen Flip to execute in Cloud mode:

1. First, duplicate the Multiscreen Flip Prototype Watermark workflow, renaming it as 
Multiscreen Flip Cloud Watermark, for example. Workflow Designer selects and 
opens it.

2. To enable Cloud mode, right-click on the Multiscreen Flip action and select Cloud 
Mode > Configure Cloud Mode. Workflow Designer displays the Configure Cloud 
Mode dialog:

Note: If Workflow Designer displays a Cloud Mode error dialog, verify that 
workflows can operate as hybrid or hosted workflows. Also make sure you have 
added a Vantage Cloud Port account in the Vantage Management Console—
Settings & Options > Telestream Cloud—and retry.

3. Configure the following settings:

Enable Vantage Cloud Port Mode. Check to enable Cloud mode for this action.

Select the Telestream Cloud Account. Specifies the Telestream Cloud account to 
utilize, which must be specified in the Vantage Management Console (Settings & 
Options > Telestream Cloud).

Select Cloud Storage to Utilize. Specifies the cloud storage bucket to utilize, 
which must be specified as an address in the Vantage Folder Address Book.
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Note: The folder you create in the Vantage Folder Address Book must use exactly 
the same name as the storage you identify in the Telestream Cloud account. This is 
required to provide translation of the signed URL specifying the location of the 
cloud-stored media to a Vantage native URL usable by the subsequent action. 
If matching entries are not included in the Vantage Folder Address Book, the URL 
translation does not occur, and downstream actions may fail. See Adding your 
Cloud Storage Account to the Vantage Folder Address Book for additional 
configuration details.

Specify Subfolder Path in Storage. Specifies an optional subfolder (bucket) path 
to use when writing files. May be statically specified and/or variables, date and time 
tokens may be applied.

Now, follow these steps to enable and configure the filter:

4. Open the Multiscreen Flip action inspector and select the x265 transcoder (or other 
transcoder) component:

x265 
Transcoder 
component 

The inspector displays its configuration panel to the right.

Watermark filter 
controls

NexGuard Streaming 
Watermark Filter

Help page for this 
inspector panel
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5. In the Settings panel, enable the NexGuard Watermark (JWT License) Filter:

The filter requires a watermark ID, preset name, NexGuard watermark strength 
value, and a license string—here shown bound to a variable. There are two ways to 
provide these values: 

– Statically, by specifying them manually, which remain the same for every job.

– Dynamically, via variables—see Providing Input Values Dynamically.

6. Configure these settings:

NexGuard Watermark ID. Specifies the payload ID (0 or 1) that NexGuard should 
use to generate the watermark. Provide the watermark ID statically or populate and 
select the variable.

Preset Name. Specifies the preset name to use when NexGuard applies the water-
mark. Provide the name statically or dynamically. The preset name (key) is provided 
to you by Nagra when you obtain a license.

NexGuard Watermark Strength. Specifies the level of watermarking to apply. 

Note: Nagra recommends leaving the watermark strength level set to Default unless 
otherwise instructed. Application of modified values requires licensing updates and 
specific, case-by-case instructions from Nagra.

Watermark License String for Cloud Deployment. Enable this control to execute 
in Telestream Cloud and supply a license string. Open the cloud license file pro-
vided by Nagra in a text editor: Select All > Copy > Paste the license string into the 
field. Alternatively, bind to a variable. For efficiency, you can create a variable in the 
Vantage Management Console, update it with the license string, and then assign 
the variable to this control. Do not use the cloud license when executing Mul-
tiscreen Flip workflows on-premises.

7. Now that you’ve configured the NexGuard Watermark (JWT) Filter, close the 
inspector.

8. Activate the workflow, and submit a test file to start a job. 

9. When the job completes, display the Job Status tab and select the job to play and 
test your watermarked media.
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Configuring the NexGuard Streaming Watermark 
Filter in Hosted Workflows

The NexGuard Streaming Watermark Filter in the Multiscreen Flip Transcoder 
component implements NexGuard for Streaming to watermark the video stream.

This topic describes configuring the action and the filter to execute in a hosted 
workflow—where the workflow is created and configured in Workflow Designer—then 
exported as a CWD file and then imported into Telestream Cloud for execution.

It isn’t necessary to enable Cloud mode on the transcoding/media processing actions. 
The entire workflow (when imported) executes in Telestream Cloud and the Cloud 
mode settings are configured directly in Telestream Cloud, instead of the action itself.

Changes you make to the prototype workflow must be made within the limits of 
hosted workflow restrictions. 

Note: Unlike the hybrid workflow requirement, you are not required to set up your 
Vantage domain for integration with Telestream Cloud to create and export hosted 
workflows. For Telestream Cloud and Vantage integration guidance, licensing, and 
limits and details on creating and configuring hybrid and hosted workflows, refer to 
the Vantage Cloud Port User Guide which is published on the Telestream web site.

Follow these steps to enable and configure the filter:

1. First, duplicate the Multiscreen Flip Prototype Watermark workflow, renaming it as 
Multiscreen Flip Hosted Watermark, for example. Workflow Designer selects and 
opens it.

2. Because this is a hosted workflow, in order to delete temporal files, right-click on 
the action and choose Cloud Mode > Output Lifespan. 

Workflow Designer displays this dialog:

3. Select Permanent to preserve the encoded output, and close the dialog.

Now, enable and configure the filter:
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4. Open the Multiscreen Flip action inspector and select the x265 (or other) 
transcoder component:

x265 
Transcoder 
component 

The inspector displays its configuration panel to the right.

Watermark filter 
controls

NexGuard Streaming 
Watermark Filter

Help page for this 
inspector panel

The filter requires a watermark ID, preset name, NexGuard watermark strength 
value, and a license string—here shown bound to a variable. There are two ways to 
provide these values: 

– Statically, by specifying them manually, which remain the same for every job.

– Dynamically, via variables—see Providing Input Values Dynamically.

5. Configure these settings:

NexGuard Watermark ID. Specifies the payload ID (0 or 1) that NexGuard should 
use to generate the watermark. Provide the watermark ID statically or populate and 
select the variable.

Preset Name. Specifies the preset name to use when NexGuard applies the water-
mark. Provide the name statically or dynamically. The preset name (key) is provided 
to you by Nagra when you obtain a license.

NexGuard Watermark Strength. Specifies the level of watermarking to apply. 
NexGuard Integration Guide



Configuring Multiscreen Flip Actions for Watermarking
Configuring the NexGuard Streaming Watermark Filter in Hosted Workflows

70 
Note: Nagra recommends leaving the watermark strength level set to Default 
unless otherwise instructed. Application of modified values requires licensing 
updates and specific, case-by-case instructions from Nagra.

Watermark License String for Cloud Deployment. Enable this control to execute 
in Telestream Cloud and supply a license string. Open the cloud license file pro-
vided by Nagra in a text editor: Select All > Copy > Paste the license string into the 
field. Alternatively, bind to a variable. For efficiency, you can create a variable in the 
Vantage Management Console, update it with the license string, and then assign 
the variable to this control. Do not use the cloud license when executing Mul-
tiscreen Flip workflows on-premises.

6. Now that you’ve configured the NexGuard Watermark (JWT) Filter, close the 
inspector to update the action.

7. Export the workflow from Workflow Designer—File > Export for Cloud.

When you export a workflow from Workflow Designer, two processes are initiated 
automatically: first, the workflow is audited to insure that it meets the criteria for a 
hosted workflow, and second, it is converted to a Compiled Workflow Document and 
saved on your local file system with a CWD extension.
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Configuring IPTV Flip 
Actions for Watermarking
The IPTV Flip action includes filters for watermarking using two different NexGuard 
products—NexGuard Embedder (deprecated) which watermarks video and audio and 
NexGuard Transcoder Plugin—which watermarks video on-premises as well as in 
hybrid and hosted workflows executing in Telestream Cloud. 

Before creating NexGuard watermarking workflows for a particular transcoding action, 
Telestream recommends that you read Implementing NexGuard Watermarking in 
Workflows, where you’ll learn about issues that apply generally to watermarking your 
media in Vantage using NexGuard. 

Topics
■ Overview

■ Creating a Prototype IPTV Flip Workflow

■ Configuring the Video NexGuard Watermark Filter

■ Configuring the Audio NexGuard Watermark Filter

■ Configuring the NexGuard Watermark (JWT License) Filter in On-Premise Workflows

■ Configuring the NexGuard Watermark (JWT License) Filter in Hybrid Workflows

■ Configuring the NexGuard Watermark (JWT License) Filter in Hosted Workflows
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Overview
The IPTV Flip action implements two NexGuard filters:

• NexGuard Watermark Filter—implements NexGuard Embedder (deprecated), for 
execution on-premises only; watermarks video and audio streams in separate fil-
ters. Supports use of NexGuard Manager.

• NexGuard Watermark (JWT License) Filter—implements the NexGuard Transcoder 
Plugin, executes on-premises and when the IPTV Flip action is configured to oper-
ate in Cloud mode or the workflow is a hosted workflow, which executes entirely in 
Telestream Cloud. Supports the use of NexGuard Manager in on-premises and 
hybrid workflows.

IPTV Flip workflows with NexGuard watermarking have the following limits/
requirements:

• Watermarking can’t be performed with codecs being used in Direct-Convert mode; 
they must decode and re-encode the video. 

• The video must be at least 2 1/2 minutes long for the watermark to be detected. For 
audio, clips must be at least 15 seconds long.

• Using the NexGuard Watermark (JWT License) Filter, if your preset name (key) is a 
short form, ClipMark key, the video must be at least 30 seconds long for the water-
mark to be detected.

• Audio watermarking is supported for PCM and AAC audio. If you want water-
marked audio in another format, first watermark PCM, then re-encode it in your 
required format; watermarking is preserved.

• You can’t watermark media in formats that don’t support watermarking, including 
those marked as Legacy.

Note: Detailed online help is provided in Workflow Designer for use when you are 
configuring an action. Double-click an action to display its inspector, where you can 
press click the M button to display the man page, which describes each component in 
detail, including controls.
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Creating a Prototype IPTV Flip Workflow
This is a basic IPTV workflow that you can use to watermark your media during 
transcoding. 

This workflow includes the following actions:

Receive—enables you to drag and drop a media file directly on the Receive action in 
Workflow Designer to start each job. Any other origin action can be used (Watch | 
Workorder, etc.), based on your job submission requirements.

IPTV Flip—The IPTV Flip action is executed by the Vantage IPTV VOD Service. The IPTV 
Flip action is included with the Cable / IPTV version of TrafficManager. IPTV Flip can 
optionally run on a Lightspeed Server for GPU-enhanced x264/x265 encoding and 
video processing. The IPTV Flip action supports the features required to handle varying 
IPTV, set-top box and cable encoding requirements, and ancillary metadata specific to 
cable ad splicing and cable/IPTV set-top box environments.

If you use NexGuard Manager, see Exchanging Job Metadata with NexGuard Manager for 
implementation details.

When you are using a machine license from Nagra, you should add a run-on rule to the 
transcoding action and configure it to execute on the server where the license is 
installed. See the Workflow Designer User’s Guide for details.

Note: Detailed online help is provided in Workflow Designer for use when you are 
configuring an action. Double-click an action to display its inspector, where you can 
press click the M button to display the man page, which describes each component in 
detail, including controls.

Follow these steps to produce your prototype IPTV Flip workflow:

1. In Workflow Designer, create a new category to store your test workflows. For 
example, NexGuard IPTV Flip Workflows.

2. Create a new workflow in this category: IPTV Prototype Watermark, for example.

3. Add a Receive action, and configure it to ingest one media file—select Original as 
the nickname.
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4. Now, add an IPTV Flip action and configure these settings:

– Inputs: Add an Auto input and select Original as the file to ingest.

– Converters: No converters are required.

– Transcoders: Add an x265 video codec and AAC audio codec. 

– Outputs: Add an MPEG-4 container and specify the output nickname as out.

5. Optionally, configure remaining settings—other than the NexGuard Streaming 
Watermark filter—as desired.

When you are using a machine license from Nagra, you should add a run-on rule to the 
transcoding action and configure it to execute on the server where the license is 
installed. See the Workflow Designer User’s Guide for details.

Now, you can use this prototype workflow as a starting point to implement 
watermarking in IPTV Flip, using each of the NexGuard products and executing on-
premises, in hybrid, and in hosted workflows, as described in the following topics.

In production, you can use any supported input you require, add converters, and 
generate output using any supported container/codec. The prototype is just an 
example—you can modify the workflow by adding other actions to suit your media 
processing requirements.
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Configuring the Video NexGuard Watermark Filter
The NexGuard Watermark Filter implements NexGuard Embedder in the IPTV Flip video 
transcoder component, when executing on-premises.

Follow the steps to enable and configure it:

1. First, duplicate the IPTV Prototype Watermark workflow, renaming it as IPTV Video 
Watermark, for example. Workflow Designer selects and opens it.

2. Open the IPTV Flip action inspector and select the x265 (or other) component:

Video Transcoder 
Component

The inspector displays its configuration panel to the right.

3. In the Settings panel, enable the NexGuard Watermark Filter:

Watermark 
filter controls

NexGuard 
Watermark Filter

Help page for this 
inspector panel

The filter requires a watermark ID and watermark key. There are three ways to pro-
vide these values: 

– Statically, by specifying them manually, which remain the same for every job 
unless edited here prior to submitting a new job.

– Dynamically, via variables—see Providing Input Values Dynamically for details.

– Using NexGuard Manager—see Exchanging Job Metadata with NexGuard 
Manager for details.
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4. Configure these settings:

NexGuard Watermark ID. Specifies the watermark (payload) ID that NexGuard 
should use to generate the watermark. If you aren’t using NexGuard Manager or it is 
temporarily unavailable, provide the watermark ID statically or populate and select 
the variable.

NexGuard Watermark Key. Specifies the key to use to apply the watermark. You 
must specify the watermark ID statically or populate and select the variable. 

When you are using a machine license in the \Vantage directory on one server in an 
array, a race condition may occur where an unlicensed transcode service updates 
the Vantage database with licensing information after the licensed transcoder ser-
vice has already done so. In this situation, the NexGuard Watermark filter won’t be 
able to populate the Watermark Key field, requiring you to add it manually.

If the NexGuard Watermark Key is a text field displaying the value Key 1, it means 
that the service was unable to access the license file or that the license information 
was updated by an unlicensed transcode service. Verify that the license file is valid 
and in the correct directory, restart the transcode service, and then retry. 

NexGuard HDR Support. When checked, enables High Dynamic Range support.

Transfer Characteristics. Specifies [Linear Gamma Corrected | DPX Cineon | Hybrid 
Log Gamma | Perceptual Quantizer]. DPX Cineon can only be used with an RGB10 
stream.

5. Now that you’ve configured the NexGuard Watermark Filter, close the inspector to 
update the action.

6. Activate the workflow, and submit a test file to start a job.

7. When the job completes, display the Job Status tab and select the job to play and 
test your watermarked media.
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Configuring the Audio NexGuard Watermark Filter
The NexGuard Watermark Filter implements NexGuard Embedder in the IPTV Flip 
transcoder’s audio component to watermark the audio track, executing on-premises.

Follow the steps to enable and configure it:

1. First, duplicate the IPTV Flip Prototype Watermark workflow, renaming it as IPTV Flip 
Audio Watermark, for example. Workflow Designer selects and opens it.

2. Open the IPTV Flip action inspector and select the AAC output component: 

Audio Stream 
Component

The inspector displays its configuration panel to the right.

3. In the configuration panel, enable the NexGuard Watermark Filter:

Watermark 
Filter controls

NexGuard 
Watermark Filter

Help page for this 
inspector panel

The filter requires a watermark ID and watermark key. There are three ways to pro-
vide these values: 

– Statically, by specifying them manually, which remain the same for every job 
unless edited here prior to submitting a new job.

– Dynamically, via variables—see Providing Input Values Dynamically for details.

– Using NexGuard Manager—see Exchanging Job Metadata with NexGuard 
Manager for details.
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4. Configure these settings:

NexGuard Watermark ID. Specifies the payload ID that NexGuard should use to 
generate the watermark. If you aren’t using NexGuard Manager or it is temporarily 
unavailable, provide the watermark ID statically or populate and select the variable.

NexGuard Watermark Key. Specifies the key to use when NexGuard applies the 
watermark. You must provide the key statically or populate and select the variable. 

Note: The IPTV Flip action’s transcode service accesses the NexGuard license file 
immediately on startup to obtain the watermark keys. When you enable the filter, 
Workflow Designer requests the keys from the transcode service. If the Watermark 
Key control displays as a menu with key selections, you know that the transcode 
service accessed the license file and keys were extracted. 
However, if the NexGuard Watermark Key is a text field displaying the value Key 1, 
it means that service was unable to access the license file. Verify that the license 
file is valid and in the correct directory, restart the transcode service, and retry.

5. Now that you’ve configured the NexGuard Watermark Filter, close the inspector.

6. Activate the workflow, and submit a test file to start a job. 

7. When the job completes, display the Job Status tab and select the job to play and 
test your watermarked media.
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Configuring the NexGuard Watermark (JWT 
License) Filter in On-Premise Workflows

The NexGuard Watermark (JWT License) Filter in the IPTV Flip output video component 
implements NexGuard Transcoder Plugin to watermark the video stream, executing on-
premises.

Follow these steps to enable and configure the filter:

1. First, duplicate the IPTV Flip Prototype Watermark workflow, renaming it as IPTV Flip 
Transcoder JWT Watermark, for example. Workflow Designer selects and opens it.

2. Open the IPTV Flip action inspector and select the x265 (or other) Transcoder 
component:

Video Transcoder 
Component

The inspector displays its configuration panel to the right.
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3. Enable the NexGuard Watermark (JWT License) Filter:

Watermark 
filter controls

NexGuard Video Watermark 
(JWT License) Filter

Help page for this 
inspector panel

The filter requires a watermark ID, preset name, and NexGuard watermark strength 
value. There are three ways to provide these values: 

– Statically, by specifying them manually, which remain the same for every job 
unless edited here prior to submitting a new job.

– Dynamically, via variables—see Providing Input Values Dynamically for details.

– Using NexGuard Manager—see Exchanging Job Metadata with NexGuard 
Manager for details. 

4. Configure these settings:

NexGuard Watermark ID. Specifies the payload ID that NexGuard should use to 
generate the watermark. If you aren’t using NexGuard Manager or it is temporarily 
unavailable, provide the watermark ID statically or populate and select the variable.

Note: If your preset name (key) is a short form, Clip Mark key, the value range for 
watermark ID is 1-1024. If you supply a value larger than 1024, the job fails with an 
out of range error.

Preset Name. Specifies the preset name to use when NexGuard applies the water-
mark. Provide the name statically or dynamically. The preset name (key) is provided 
to you by Nagra when you obtain a license.

NexGuard Watermark Strength. Specifies the level of watermarking to apply.
NexGuard Integration Guide



Configuring IPTV Flip Actions for Watermarking 
Configuring the NexGuard Watermark (JWT License) Filter in On-Premise Workflows

81
Note: Nagra recommends leaving the watermark strength level set to Default 
unless otherwise instructed. Application of modified values requires licensing 
updates and specific, case-by-case instructions from Nagra.

Watermark License String for Cloud Deployment. Disabled by default for execu-
tion on-premises.

5. Now that you’ve configured the NexGuard Watermark (JWT) Filter, close the 
inspector.

6. Activate the workflow, and submit a test file to start a job. 

7. When the job completes, display the Job Status tab and select the job to play and 
test your watermarked media.
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Configuring the NexGuard Watermark (JWT 
License) Filter in Hybrid Workflows

The NexGuard Watermark (JWT License) Filter in the IPTV Flip Transcoder component 
implements NexGuard Transcoder Plugin to watermark the video stream.

The NexGuard Watermark (JWT License) Filter may be executed in on-premise 
workflows and in transcoding actions operating in Cloud mode. You must execute 
Notify action on-premises to interchange metadata with NexGuard Manager.

Note: If you haven’t set up your Vantage domain for operating in Telestream Cloud, 
you should do so before proceeding. For Telestream Cloud and Vantage integration 
guidance, licensing, and details on using hybrid and hosted workflows in Telestream 
Cloud, refer to the Vantage Cloud Port User Guide on our web site.

With your Vantage domain configured to integrate with Telestream Cloud, follow these 
steps to configure IPTV Flip to execute in Cloud mode:

1. First, duplicate the IPTV Flip Prototype Watermark workflow, renaming it as IPTV Flip 
Cloud Watermark, for example. Workflow Designer selects and opens it.

2. Right-click on the IPTV Flip action and select Cloud Mode > Configure Cloud Mode. 
Workflow Designer displays the Configure Cloud Mode dialog:

Note: If Workflow Designer displays a Cloud Mode error dialog, verify that 
workflows can operate as hybrid or hosted workflows. Also make sure you have 
added a Vantage Cloud Port account in the Vantage Management Console—
Settings & Options > Telestream Cloud—and retry.
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3. Configure the following settings:

Enable Vantage Cloud Port Mode. Check to enable this action to execute in 
Telestream Cloud, independently of other actions in the workflow.

Select the Telestream Cloud Account. Specifies the Telestream Cloud account to 
utilize, which must be specified in the Vantage Management Console (Settings & 
Options > Telestream Cloud).

Select Cloud Storage to Utilize. Specifies the cloud storage bucket to utilize, 
which must be specified as an address in the Vantage Folder Address Book.

Note: The folder you create in the Vantage Folder Address Book must use exactly 
the same name as the storage you identify in the Telestream Cloud account. This is 
required to provide translation of the signed URL specifying the location of the 
cloud-stored media to a Vantage native URL usable by the subsequent action. 
If matching entries are not included in the Vantage Folder Address Book, the URL 
translation does not occur, and downstream actions may fail. See Adding your 
Cloud Storage Account to the Vantage Folder Address Book for configuration details.

Specify Subfolder Path in Storage. Specifies an optional subfolder (bucket) path 
to use when writing files. May be statically specified and/or variables, date and time 
tokens may be applied.

4. Now, enable and configure the filter—open the IPTV Flip action inspector and 
select the x265 Transcoder component:

Video Transcoder 
Component
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The inspector displays its configuration panel to the right.

Watermark filter 
controls

NexGuard Video 
Watermark (JWT 
License) Filter

Help page for this 
inspector panel

5. In the Settings panel, enable the NexGuard Watermark (JWT License) Filter.

The filter requires a watermark ID, preset name, NexGuard watermark strength, and 
a license string for Telestream Cloud (shown here bound to a variable) value. There 
are three ways to provide these values: 

– Statically, by specifying them manually, which remain the same for every job.

– Dynamically, via variables—see Providing Input Values Dynamically for details.

– Using NexGuard Manager—see Exchanging Job Metadata with NexGuard 
Manager for details.

6. Configure these settings:

NexGuard Watermark ID. Specifies the payload ID that NexGuard should use to 
generate the watermark. If you aren’t using NexGuard Manager or it is temporarily 
unavailable, provide the watermark ID statically or populate and select the variable.

Note: If your preset name (key) is a clip mark key, the value range for watermark 
ID is 1-1024. If you supply a key larger than 1024, the job fails with an out of range 
error.

Preset Name. Specifies the preset name to use when NexGuard applies the water-
mark. Provide the name statically or dynamically. The preset name (key) is provided 
to you by Nagra when you obtain a license.

NexGuard Watermark Strength. Specifies the level of watermarking to apply. 
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Note: Nagra recommends leaving the watermark strength level set to Default 
unless otherwise instructed. Application of modified values requires licensing 
updates and specific, case-by-case instructions from Nagra.

Watermark License String for Cloud Deployment. Enable this control to execute 
in Telestream Cloud and supply a license string. Enable this control to execute in 
Telestream Cloud and supply a license string. Open the cloud license file provided 
by Nagra in a text editor: Select All > Copy > Paste the license string into the field. 
Alternatively, bind to a variable. For efficiency, you can create a variable in the Van-
tage Management Console, update it with the license string, and then assign the 
variable to this control. Do not use the cloud license when executing IPTV Flip on-
premises.

7. Now that you’ve configured the NexGuard Watermark (JWT) Filter, close the 
inspector.

8. Activate the workflow, and submit a test file to start a job.

9. When the job completes, display the Job Status tab and select the job to play and 
test your watermarked media.
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Configuring the NexGuard Watermark (JWT 
License) Filter in Hosted Workflows

The NexGuard Watermark (JWT License) Filter implements the NexGuard Transcoder 
Plugin in the IPTV Flip Transcoder component to watermark the video stream.

Watermarking with the NexGuard Transcoder Plugin may be performed in on-premise 
workflows, and it may also be performed in transcoding actions executing in 
Telestream Cloud.

This topic describes configuring the action and the filter to execute in a hosted 
workflow—where the workflow is created and configured in Workflow Designer—then 
exported as a CWD file and then imported into Telestream Cloud for execution.

It isn’t necessary to enable Cloud mode on the transcoding/media processing actions. 
The entire workflow (when imported) executes in Telestream Cloud and the Cloud 
mode settings are configured directly in Telestream Cloud, instead of the action itself.

Changes you make to the prototype workflow must be made within the limits of 
hosted workflow restrictions. 

Note: Unlike the hybrid workflow requirement, you are not required to set up your 
Vantage domain for integration with Telestream Cloud to create and export hosted 
workflows. For Telestream Cloud and Vantage integration guidance, licensing, and 
limits and details on creating and configuring hybrid and hosted workflows, refer to 
the Vantage Cloud Port User Guide on the web site.

Follow these steps to configure IPTV Flip to execute in a hosted workflow:

1. First, duplicate the IPTV Flip Prototype Watermark workflow, renaming it as IPTV Flip 
Hosted Watermark, for example. Workflow Designer selects and opens it.

2. Because this is a hosted workflow, in order to delete temporal files, right-click on 
the action and choose Cloud Mode > Output Lifespan. 

Workflow Designer displays this dialog:

3. Select Permanent to preserve the encoded output, and close the dialog.
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4. Now, enable and configure the filter—open the IPTV Flip action inspector and 
select the x265 Transcoder component:

Video 
Transcoder 
Component

The inspector displays its configuration panel to the right.

Watermark filter 
controls

NexGuard Video 
Watermark (JWT 
License) Filter

Help page for this 
inspector panel

5. In the Settings panel, enable the NexGuard Watermark (JWT License) Filter.

The filter requires a watermark ID, preset name, NexGuard watermark strength, and 
a license string for Telestream Cloud (shown here bound to a variable) value. There 
are two ways to provide these values: 

– Statically, by specifying them manually, which remain the same for every job.

– Dynamically, via variables—see Providing Input Values Dynamically for details.

6. Configure these settings:

NexGuard Watermark ID. Specifies the payload ID that NexGuard should use to 
generate the watermark. If you aren’t using NexGuard Manager or it is temporarily 
unavailable, provide the watermark ID statically or populate and select the variable.
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Note: If your preset name (key) is a clip mark key, the value range for watermark 
ID is 1-1024. If you supply a key larger than 1024, the job fails with an out of range 
error.

Preset Name. Specifies the preset name to use when NexGuard applies the water-
mark. Provide the name statically or dynamically. The preset name (key) is provided 
to you by Nagra when you obtain a license.

NexGuard Watermark Strength. Specifies the level of watermarking to apply. 

Note: Nagra recommends leaving the watermark strength level set to Default 
unless otherwise instructed. Application of modified values requires licensing 
updates and specific, case-by-case instructions from Nagra.

Watermark License String for Cloud Deployment. Enable this control to execute 
in Telestream Cloud and supply a license string. Open the cloud license file pro-
vided by Nagra in a text editor: Select All > Copy > Paste the license string into the 
field. Alternatively, bind to a variable. For efficiency, you can create a variable in the 
Vantage Management Console, update it with the license string, and then assign 
the variable to this control. Do not use the cloud license when executing Mul-
tiscreen Flip on-premises.

7. Now that you’ve configured the NexGuard Watermark (JWT) Filter, close the 
inspector.

8. Export the workflow from Workflow Designer—File > Export for Cloud.

When you export a workflow from Workflow Designer, two processes are initiated 
automatically: first, the workflow is audited to insure that it meets the criteria for a 
hosted workflow, and second, it is converted to a Compiled Workflow Document and 
saved on your local file system with a CWD extension.

With the workflow exported, your work in Vantage is complete. Follow these steps to 
import your workflow into your Telestream Cloud and process media using it:

1. Log into your Telestream Cloud account to import the CWD file and prepare it for 
deployment and execution in Telestream Cloud.

2. Using your custom submission program, submit a test file to start a job in 
Telestream Cloud.

3. When the job completes, you can play and test your watermarked media.
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Configuring Conform 
Actions for Watermarking
The Conform action includes filters for watermarking using two different NexGuard 
products—NexGuard Embedder (deprecated) which watermarks video and audio and 
NexGuard Transcoder Plugin—which watermarks video on-premises as well as in 
hybrid and hosted workflows executing in Telestream Cloud. 

Before creating NexGuard watermarking workflows for a particular transcoding action, 
Telestream recommends that you read Implementing NexGuard Watermarking in 
Workflows, where you’ll learn about issues that apply generally to watermarking your 
media in Vantage using NexGuard. 

Topics
■ Overview

■ Creating a Prototype Workflow

■ Configuring the Video NexGuard Watermark Filter

■ Configuring the NexGuard Watermark (JWT License) Filter in On-Premise Workflows
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Overview
The Conform action renders multi-layer video compositions (as defined in a 
Composition XML file which it is passed) with transition and image effects and graphic 
overlays and conformed audio, applying option filters as appropriate, encoding the 
output video in the specified format. 

The Conform action includes filters for watermarking using two different NexGuard 
products:

• NexGuard Watermark Filter—implements NexGuard Embedder (deprecated), for 
execution on-premises only; watermarks video streams only. Supports use of Nex-
Guard Manager.

• NexGuard Watermark (JWT License) Filter—implements the NexGuard Transcoder 
Plugin, executes on-premises. Supports the use of NexGuard Manager.

Conform action workflows with NexGuard watermarking have the following limits/
requirements: 

• Watermarking can’t be performed with codecs being used in Direct-Convert mode; 
they must decode and re-encode the video. 

• The video must be at least 2 1/2 minutes long for the watermark to be detected. For 
audio, clips must be at least 15 seconds long.

• You can’t watermark media in formats or containers that don’t support watermark-
ing, including those marked as Legacy.
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Creating a Prototype Workflow
This is a basic Conform workflow that you can use to watermark your media during 
transcoding. 

This workflow includes the following actions:

Receive—enables you to drag and drop a media file directly on the Receive action in 
Workflow Designer to start each job. Any other origin action can be used (Watch | 
Workorder, etc.), based on your job submission requirements.

Conform—the Conform action is a Vantage Cloud Port-capable, 64-bit multi-core-
optimized encoder running under the Vantage Edit Service (except in Cloud mode, 
when it is executed by the Telestream Cloud Service, operating as a proxy of the Edit 
Service). It transcodes media from one format into another format as specified by the 
output configuration you specify. Resolutions extend from SD to UltraHD and 4K in a 
broad range of file formats, from QuickTime to MPEG-4 and TIFO, and including 
encoding for x264, x265 (H.265 HEVC), MXF, and more.

If you use NexGuard Manager, see Exchanging Job Metadata with NexGuard Manager for 
implementation details.

When you are using a machine license from Nagra, you should add a run-on rule to the 
transcoding action and configure it to execute on the server where the license is 
installed. See the Workflow Designer User’s Guide for details.

Note: Detailed online help is provided in Workflow Designer for use when you are 
configuring an action. Double-click an action to display its inspector, where you can 
press click the M button to display the man page, which describes each component in 
detail, including controls.
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Follow these steps to create your prototype Conform workflow:

1. In Workflow Designer, create a new category to store your test workflows. For 
example, NexGuard Conform Workflows.

2. Create a new workflow in this category: Conform Prototype Watermark, for example.

3. Add a Receive action, and configure it to ingest one media file—select Original as 
the nickname.

4. Now, add a Conform action and configure these general settings:

– Input File Nickname: Select Original as the nickname to ingest.

– Generate Composition Chronicle: none are required in the prototype.

– Transcoders: Add an x265 video transcoder and AAC audio transcoder.

– Outputs: Add an MPEG-4 container and specify the output nickname as Out.

– Processors: none are required in the prototype.

5. Optionally, configure remaining settings—other than the NexGuard Watermark 
filters—as desired. 

When you are using a machine license from Nagra, you should add a run-on rule to the 
transcoding action and configure it to execute on the server where the license is 
installed. See the Workflow Designer User’s Guide for details.

Now, you can use this prototype workflow as a starting point to implement 
watermarking in Conform, executing on-premises, in hybrid, and in hosted workflows, 
as described in the following topics.

In production, you can add processors, and make other changes as required. The 
prototype is just an example—you can modify the workflow by adding other actions to 
suit your media processing requirements.
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Configuring the Video NexGuard Watermark Filter
The NexGuard Watermark Filter in the Conform video transcoder component 
implements NexGuard Embedder for watermarking the video, executing on-premises.

Follow these steps to enable and configure it:

1. First, duplicate the Conform Prototype Watermark workflow, renaming it as 
Conform Video Watermark, for example. Workflow Designer selects and opens it.

2. Open the Conform action inspector and select the x265 transcoder component:

Video Transcoder 
Component

The inspector displays its configuration panel to the right.

3. In the Video Processor settings, enable the NexGuard Watermark Filter:

Watermark filter 
controls

NexGuard 
Watermark Filter

Help page for this 
inspector panel

The filter requires a watermark ID and watermark key. There are three ways to pro-
vide these values: 

– Statically, by specifying them manually, which remain the same for every job.

– Dynamically, via variables—see Providing Input Values Dynamically.

– Using NexGuard Manager—see Exchanging Job Metadata with NexGuard 
Manager.
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4. Configure these settings:

NexGuard Watermark ID. Specifies the watermark (payload) ID that NexGuard 
should use to generate the watermark. If you aren’t using NexGuard Manager or it is 
temporarily unavailable, provide the watermark ID statically or populate and select 
the variable.

NexGuard Watermark Key. Specifies the key to use when NexGuard applies the 
watermark. You must specify the watermark ID statically or populate and select the 
variable. 

Note: When you are using a machine license in the \Vantage directory on one 
server in an array, a race condition may occur where an unlicensed transcode 
service updates the Vantage database with licensing information after the 
licensed transcoder service has already done so. In this situation, the NexGuard 
Watermark filter won’t be able to populate the Watermark Key field, requiring you 
to add it manually.

NexGuard HDR Support. When checked, enables High Dynamic Range support.

Transfer Characteristics. Specifies [Linear Gamma Corrected | DPX Cineon | Hybrid 
Log Gamma | Perceptual Quantizer]. DPX Cineon can only be used with an RGB10 
stream.

5. Now that you’ve configured the NexGuard Watermark Filter, close the inspector.

6. Activate the workflow, and submit a test file to start a job. 

7. When the job completes, display the Job Status tab and select the job to play and 
test your watermarked media.
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Configuring the NexGuard Watermark (JWT 
License) Filter in On-Premise Workflows

The NexGuard Watermark (JWT License) Filter in the Conform action’s transcoder 
component implements the NexGuard Transcoder Plugin to apply a watermark to the 
video stream.

Follow these steps to configure it for use in on-premise workflows:

1. First, duplicate the Conform Prototype Watermark workflow, renaming it as 
Conform JWT Watermark, for example. Workflow Designer selects and opens it.

2. Open the Conform action inspector and select the x265 (or other) transcoder:

Video 
Transcoder 
Component

3. The inspector displays its configuration panel to the right.

Watermark 
filter controls

NexGuard Video 
Watermark (JWT License) 
Filter

Help page for this 
inspector panel
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4. In the Settings > Video Processor panel, enable the NexGuard Watermark (JWT 
License) Filter:

The filter requires a watermark ID, preset name, and NexGuard watermark strength 
value. There are three ways to provide these values: 

– Statically, by specifying them manually, which remain the same for every job.

– Dynamically, via variables—see Providing Input Values Dynamically.

– Using NexGuard Manager—see Exchanging Job Metadata with NexGuard 
Manager. 

5. Configure these settings:

NexGuard Watermark ID. Specifies the payload ID that NexGuard should use to 
generate the watermark. If you aren’t using NexGuard Manager or it is temporarily 
unavailable, provide the watermark ID statically or populate and select the variable.

Note: If your preset name is a clip mark key, the value range for watermark ID is 1-
1024. If you supply a key larger than 1024, the job fails with an out of range error.

Preset Name. Specifies the preset name to use when NexGuard applies the water-
mark. Provide the name statically or dynamically. The preset name (key) is provided 
to you by Nagra when you obtain a license.

NexGuard Watermark Strength. Specifies the level of watermarking to apply.

Note: Nagra recommends leaving the watermark strength level set to Default 
unless otherwise instructed. Application of modified values requires licensing 
updates and specific, case-by-case instructions from Nagra.

Watermark License String for Cloud Deployment. Disabled by default for execu-
tion on-premises.

6. Now that you’ve configured the NexGuard Watermark (JWT) Filter, close the 
inspector.

7. Activate the workflow, and submit a test file to start a job.

8. When the job completes, display the Job Status tab and select the job to play and 
test your watermarked media.
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Configuring Flip Actions 
for Watermarking
The Flip action includes NexGuard filters for watermarking video and audio, using 
NexGuard Embedder (deprecated). The Flip action executes only in on-premise 
Vantage domains—it does not execute in Telestream Cloud.

Before creating NexGuard watermarking workflows for a particular transcoding action, 
Telestream recommends that you read Implementing NexGuard Watermarking in 
Workflows, where you’ll learn about issues that apply generally to watermarking your 
media in Vantage using NexGuard. 

Topics
■ Overview

■ Creating a Prototype Workflow

■ Configuring the Video NexGuard Watermark Filter

■ Configuring the Audio NexGuard Watermark Filter
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Overview
The Flip action implements NexGuard Embedder (deprecated) in NexGuard Watermark 
Filters for both audio and video, for execution on-premises. 

Flip workflows with NexGuard watermarking have the following limits/requirements:

• You can’t watermark media in formats that don’t support watermarking, including 
those marked as Legacy.

• Watermarking can’t be performed with codecs being used in Direct-Convert mode; 
they must decode and re-encode the video. 

• The video must be at least 2 1/2 minutes long for the watermark to be detected. For 
audio, clips must be at least 15 seconds long.

• The video must be encoded with Multi-core or Lightspeed Accelerated processors.

• Audio watermarking is supported for PCM and AAC audio. If you want water-
marked audio in another format, first watermark PCM, then re-encode it in your 
required format; watermarking is preserved.
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Creating a Prototype Workflow
This is a basic Flip workflow that you can use to watermark your media during 
transcoding. You can modify the workflow by adding other actions to suit your media 
processing requirements.

This workflow includes the following actions:

Receive—enables you to drag and drop a media file directly on the Receive action in 
Workflow Designer to start each job. Any other origin action can be used (Watch | 
Workorder, etc.), based on your job submission requirements.

Flip—The Flip action is executed by the Transcode Service, which implements a broad 
range of codecs to transcode decoded digital baseband media into another media 
encoding format.

If you use NexGuard Manager, see Exchanging Job Metadata with NexGuard Manager for 
implementation details.

If you are using a Nagra machine license, you should add a run-on rule to the 
transcoding action and configure it to execute on the server where the license is 
installed. See the Workflow Designer User’s Guide for details.

Note: Detailed online help is available in Workflow Designer for use when you are 
configuring an action. Double-click an action to display its inspector, where you can 
press click the M button to display the man page, which describes each component in 
detail, including controls.
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Follow these steps to create your prototype Flip workflow:

1. In Workflow Designer, create a new category to store your NexGuard workflows. For 
example, Flip NexGuard Workflows.

2. Create a new workflow: Flip Prototype Watermark, for example.

3. Add a Receive action, and configure it to ingest a media file—select Original as the 
nickname.

4. Now, add a Flip action and configure these settings:

– Encoder: Select MXF Encoder or other encoder that includes PCM audio.

– Input Media File Nickname: Select Original as the source file to ingest.

– Output Media File Nickname: Select out as the output file.

– Configure the video stream to use the Multi-core or Lightspeed Accelerated 
processor.

– Configure the Audio Stream to use the PCM codec.

5. Optionally, configure remaining settings—other than the NexGuard Watermark 
filters—as desired.

When you are using a machine license from Nagra, you should add a run-on rule to the 
transcoding action and configure it to execute on the server where the license is 
installed. See the Workflow Designer User’s Guide for details.

Now, you can use this prototype workflow as a starting point to implement 
watermarking in Flip, executing on-premises, as described in the following topics.

In production, you can use any supported input you require, add converters, and 
generate output using any supported container/codec. The prototype is just an 
example—you can modify the workflow by adding other actions to suit your media 
processing requirements.
NexGuard Integration Guide



Configuring Flip Actions for Watermarking 
Configuring the Video NexGuard Watermark Filter

101
Configuring the Video NexGuard Watermark Filter
The NexGuard Watermark Filter implements NexGuard Embedder in the Flip Video 
Stream component to watermark the video stream, when executing on-premises.

Follow these steps to enable and configure it:

1. First, duplicate the Flip Prototype Watermark workflow, renaming it as Flip Video 
Watermark, for example. Workflow Designer selects and opens it.

2. Open the Flip action inspector and select the Video Stream component.

Video Filter 
menu

Video Stream 

NexGuard Video 
Watermark Filter

Help page for this 
inspector panel

3.  Now, add the NexGuard Watermark filter—select NexGuard Watermark from the 
Video Filter menu.

The inspector displays its configuration panel below.

Watermark 
filter controls

The filter requires a watermark ID and watermark key. There are three ways to pro-
vide these values:

– Statically, by specifying them manually, which remain the same for every job.

– Dynamically, via variables—see Providing Input Values Dynamically.

– Using NexGuard Manager—see Exchanging Job Metadata with NexGuard 
Manager.
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4. Configure these settings:

NexGuard Watermark ID. Specifies the watermark (payload) ID that NexGuard 
should use to generate the watermark. If you aren’t using NexGuard Manager or it is 
temporarily unavailable, provide the watermark ID statically or populate and select 
the variable.

NexGuard Watermark Key. Specifies the key to use when NexGuard applies the 
watermark. Select from the list in the menu.

Note: When you are using a machine license in the \Vantage directory on one 
server in an array, a race condition may occur where an unlicensed transcode 
service updates the Vantage database with licensing information after the 
licensed transcoder service has already done so. In this situation, the NexGuard 
Watermark filter won’t be able to populate the Watermark Key field, requiring you 
to add it manually.

NexGuard HDR Support. When checked, enables High Dynamic Range support.

Transfer Characteristics. Specifies [Linear Gamma Corrected | DPX Cineon | Hybrid 
Log Gamma | Perceptual Quantizer]. DPX Cineon can only be used with an RGB10 
stream.

5. Now that you’ve configured the NexGuard Watermark Filter, close the inspector to 
update the action.

6. Activate the workflow, and submit a test file to start a job.

7. When the job completes, display the Job Status tab and select the job to play and 
test your watermarked media.
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Configuring the Audio NexGuard Watermark Filter
The NexGuard Watermark Filter implements NexGuard Embedder in the Flip Audio 
Stream component to watermark the audio track, when executing on-premises.

Follow these steps to enable and configure it:

1. First, duplicate the Flip Prototype Watermark workflow, renaming it as Flip Audio 
Watermark, for example. Workflow Designer selects and opens it.

2. Open the Flip action inspector and select the Audio Stream component.

Audio filter 
menu

Audio Stream

NexGuard Audio 
Watermark Filter

3.  Now, add the NexGuard Watermark filter—select NexGuard Watermark from the 
Audio Filter menu.

The inspector displays its configuration panel below:

Watermark 
filter controls

The filter requires a watermark ID and watermark key. There are three ways to pro-
vide these values:

– Statically, by specifying them manually, which remain the same for every job.

– Dynamically, via variables—see Providing Input Values Dynamically.

– Using NexGuard Manager—see Exchanging Job Metadata with NexGuard 
Manager.

4. Configure these settings:

NexGuard Watermark ID. Specifies the watermark (payload) ID that NexGuard 
should use to generate the watermark. If you aren’t using NexGuard Manager or it is 
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temporarily unavailable, provide the watermark ID statically or populate and select 
the variable.

NexGuard Watermark Key. Specifies the key to use when NexGuard applies the 
watermark. Select from the list in the menu.

Note: When you are using a machine license in the \Vantage directory on one 
server in an array, a race condition may occur where an unlicensed transcode 
service updates the Vantage database with licensing information after the 
licensed transcoder service has already done so. In this situation, the NexGuard 
Watermark filter won’t be able to populate the Watermark Key field, requiring you 
to add it manually.

5. Now that you’ve configured the NexGuard Watermark Filter, close the inspector to 
update the action.

6. Activate the workflow, and submit a test file to start a job.

7. When the job completes, display the Job Status tab and select the job to play and 
test your watermarked media.
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Troubleshooting
These topics describe common problems you may face, with likely causes and 
suggested resolutions.

For further assistance, contact Telestream Customer Service (See Contacting 
Telestream).

Topics
■ Vantage Licensing Issues

■ NexGuard Licensing Issues

■ NexGuard Notifier Connection Issues

■ Transcode Action Issues
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Vantage Licensing Issues
Issue: You open a Flip | Flip64 | Conform | Multiscreen Flip action inspector, and no 
NexGuard filters display.

Likely Causes: 

• The service that executes this action could not identify the appropriate Vantage 
NexGuard Filter license, and thus, did not display the NexGuard filter panel.

• You’re attempting to watermark video or audio, but the action you’re using does 
not support video watermarking for the chosen codec, or does not support audio 
watermarking for the chosen codec, or does not support it at all. 

Resolution: Verify that (see Obtaining & Applying Vantage & NexGuard Licenses):

• You have obtained and installed the Vantage license. 

• Verify that you have placed the license(s) on the appropriate server, path and folder.

• Restart the Vantage services and retry.

For further assistance, contact Telestream Customer Service (See Contacting 
Telestream).

NexGuard Licensing Issues
Issue: A Flip-based workflow attempts to apply a NexGuard watermark. In the Job 
Status tab, the Flip action in the job displays 0% completion continuously.

Likely Cause: The transcoder attempted to watermark the media without identifying 
the appropriate NexGuard license or there are no seats available. 

Resolution: Stop the job and view the LicError.log files in C:\Program Files 
(x86)\Telestream\Vantage\NexGuard Audio Watermarking License and C:\Program Files 
(x86)\Telestream\Vantage\NexGuard Video Watermarking License.

Read the error and fix the problem, then retry the workflow.

The NexGuard license determines how many concurrent watermarks a Vantage 
machine can do at a given time. These are referred to as seats. If the license has fewer 
seats than the number of concurrently running transcoding actions with the NexGuard 
Watermark filter, some of the transcoding actions will idle at 0% until a seat becomes 
available. If a transcoding action is unable to acquire a seat due to all the seats 
continually being in use, it will eventually time out as specified by the timeout value of 
the service.

Verify that you have...

• obtained and installed the NexGuard license

• entered the correct IP | Name in the license files to identify the server where the 
license is located

• successfully PINGed the server you are targeting
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• placed the float license(s) on the appropriate server, path and folder.

Restart the Vantage Transcode service and retry.

For further assistance, contact Telestream Customer Service (See Contacting 
Telestream).

If Vantage attempts to apply a NexGuard Watermark without a license, it displays this 
error message:

An error occurred during execution of the Transcode Task: Process Id = #### An 
unrecoverable error has been encountered within the Transcoder. The transcode process 
has stopped responding as a result of a crash. Please attempt to re-run the transcode.

NexGuard Notifier Connection Issues
Issue: You are configuring the Notify action’s NexGuard Notifier to communicate with 
NexGuard Manager. When you click Test or Next, Vantage displays the error 
“Connection failed...” or “Unable to retrieve the list of keys from NexGuard Manager” or 
similar.

Likely Causes: 

• The host name | IP address or port number (default 80) is incorrect.

• The credentials are incorrect.

• You are using an incorrect interface for this version of NexGuard Manager.

Resolution: Verify the information, update the configuration and try again.

Note: A successful connection in Workflow Designer validates the host, port, and 
credentials. However, the Vantage Communicate Service which executes the Notify 
action may not be able to connect, based on its own Windows permissions.

Transcode Action Issues
Issue: Transcode actions idle at 0% completion.

Likely Cause: The NexGuard license you have specifies how many watermark 
operations a Vantage service can perform simultaneously. These are referred to as seats. 
If a license has fewer seats than the number of concurrently-running transcoding 
actions, some will idle at 0% until a seat becomes available. If an action is unable to 
acquire a seat due to all seats continually being in use, it will eventually time out, as 
specified by the timeout value of the Transcode (or other) service.

Resolution: Wait until workflows complete before starting new jobs to reduce seat 
overload. Or, add more seats to your license.
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Issue: Flip action fails: “An error occurred during execution of the Transcode Task... 
RenderSesson Configuration Error, message: Encoder Setup Rejected due to the 
configuration of a video filter is invalid”.

Likely Cause: The Key you provided is not valid.

Resolution: Validate your license key, update, and retry.

Issue: Workflow fails on Transcode action.

Likely Cause: In Workflow Manager, select the offending workflow and right-click on 
the transcode action displayed in red to display the Status/History dialog and review 
details.

Resolution: For example, your Vantage domain may be missing a NexGuard license—
remedy and retry.
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